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Preface 
As the whole world seems to be moving to client/server and 
Windows, many Tandem customers have come to realize the 
advantages of an intuitive and productive graphic mouse-
driven interface with all its in-built benefits. Matterhorn for 
Windows took your Tandem system most of the way, but with 
Screen Designer you possess a tool which will make your 
current system attractive, well-organized, flexible, and easy to 
use. 

With Matterhorn Screen Designer at your fingertips, a world 
of unprecedented opportunities unfolds. Screen Designer 
enables you to optimize and fashion your current Tandem 
requester system in a series areas important to your work. 
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About This Manual 
The Screen Designer Setup and Reference Guide describes the 
features and applications of the GUI development 
environment, Screen Designer. The manual will serve as your 
guide and tutor as you learn the fundamentals of Screen 
Designer. 

Details on installing and using the many features of Screen 
Designer are to be found on these pages. The manual is 
organized as follows: 

Chapter 1, Features of Screen Designer, presents the many 
powerful features of  Matterhorn Screen Designer.  

Chapter 2, Installing Screen Designer, takes you through 
the installation procedure of Matterhorn Screen Designer. 

Chapter 3, How Does Screen Designer Work, explains how 
Screen Designer works and how it interacts with 
Matterhorn 5.0 for Windows and your Tandem system at 
runtime. 

Chapter 4, Elements of Screen Designer, presents the main 
elements of Screen Designer. You will learn about the 
structure of the Screen Designer application window and 
the many functions available from the pull-down menu 
and the tool bar. 

Chapter 5, Screen Designer Objects, explains the term 
Screen Designer object and describes how to work with 
objects in Screen Designer. The Object Inspector will be 
introduced. 
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Chapter 6, Using Screen Designer, explains in detail how to 
use Screen Designer. All features will be thoroughly 
discussed and exemplified. 

Chapter 7, Matterhorn Macro Language, discusses the 
macro programming language, which is part of the 
Matterhorn Suite. The Matterhorn macro language enables 
you to to speed up and simplify administrative tasks or 
exchange data with other applications that support DDE or 
DLL. Note that the macro statements which are used for for 
DDE and DLL require a MattOpen license. 

Chapter 8, Data Explorer, presents the applications, layout, 
and functions available from the productivity tool, Data 
Explorer. 

Glossary is an alphabetical list of explanations of terms and 
abbreviations appearing in the manual. 

Note that all screen shots in this manual have been shot under 
Windows 95. 

Who Should Read This Book 
The Screen Designer Reference Guide is primarily designed for 
users in your company that are involved in setting up 
requester screens. In order to maximize the application of 
Screen Designer, we strongly advise that the users of Screen 
Designer consult the representatives of the various groups of 
users in your company prior to designing new requester 
screens. A system administrator who is an expert on 
computers may not be the right person to determine which 
screens and fields are relevant to which groups of users. 
Coordination and cooperation are both keywords when using 
Matterhorn Screen Designer. 
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Introducing Screen Designer 
elcome to Matterhorn Screen Designer 5.0, the unique 
GUI development environment. This manual will tell 

you what Screen Designer is all about and how it works. You 
will learn how to install and use its many features. 

 
Figure I.1: Design your requester screens with Screen Designer. 

 

W 
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Introducing Screen Designer 
Below is an outline of the many features of Screen Designer. 
Using Screen Designer you may: 

• Rearrange screen objects. 

• Remove screen objects from the screen. 

• Insert graphics and change the color and size of any 
screen object. 

• Create and associate selection lists and entry histories 
with edit fields and assign click actions to edit fields 
and graphics. 

• Insert and run multimedia objects, including video 
and sound clips to further fashion your Tandem 
requesters. 

• Create tabbed notebooks to organize your screens 
better. 

• Insert backgrounds such as wallpaper and gradients. 

• Associate push buttons with function keys and 
macros. 

• Insert frames around selected fields. 

• Map function keys. 

• Create and run DDE macros in order to set up DDE 
conversations with any DDE-compatible application. 

• Design requester screens for specific groups of users.  
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Screen Designer Provides Flexibility 
Matterhorn Screen Designer not only opens up your current 
Tandem system to the client/server-technology. It also 
provides your company with the opportunity to evaluate and 
discuss the design of your current Tandem system. Does it 
offer the required flexibility? Are things perhaps too complex 
for the users? Is there a way to improve the system’s current 
design? Quite often, the answers to these questions are: no, yes, 
and yes. And that’s when Screen Designer comes into its own. 

The Matterhorn Suite 
Before we go on to explore Screen Designer in detail, here is a 
brief introduction to the Matterhorn Suite of software 
products. The suite is comprised of the following four 
software products: Matterhorn for Windows, Screen Designer, 
MattWeb, and MattOpen. 

Matterhorn for Windows  
Matterhorn for Windows forms the core of the Matterhorn 
Suite. Matterhorn enables you to access your legacy Pathway 
applications from the PC and run them as client/server-based 
applications. 

Matterhorn is easy to install and configure; both on Tandem 
and on PC and it operates equally well on both Windows 3.xx, 
Windows 95, and Windows NT platforms. Your Pathway 
applications will be running graphic interfaces in no time.  
 
With Matterhorn for Windows, the maintainability of your 
current Tandem system is intact. No cost and time-consuming 
application conversions are required. Programmers do not 
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have to rewrite one single line of code when deploying 
Matterhorn for Windows.  

As you may be aware, Screen Designer is designed to 
complement and extend Matterhorn for Windows. You cannot 
use Screen Designer without having implemented Matterhorn 
for Windows on your system. Matterhorn for Windows comes 
both as a 16- and a 32-bit application. 

If you are already using Matterhorn for Windows it is very 
simple to get started with Screen Designer. For more 
information about using Matterhorn for Windows, please 
study the Matterhorn Setup and Reference Guide. 

MattWeb  
These days many Tandem customers are considering going on 
the Internet. The Internet is hot. And intranets may become 
even hotter. At Skybeam we have committed ourselves to 
provide the Tandem world with the best Internet/intranet 
solution. 

MattWeb is the only solution that is designed to present 
Pathway applications graphically on the World Wide Web. At 
the same time you may use MattWeb to establish your own 
intranet.  

MattWeb fully supports requesters which has been designed 
with Screen Designer. At runtime, each screen element will be 
presented on the remote user’s monitor by Java applets. 

With MattWeb and Matterhorn Screen Designer in unison you 
may create multiple mode applications. Different versions of the 
same application can be run simultaneously on the Internet 
and your own network. 

Screen Designer and MattWeb offer the same kind of 
flexibility to your company internally. You are not restricted to 
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settle for a permanent client interface. For instance, one third 
of the users in your company may run requesters as 
Matterhorn sessions; another third may run the same 
requesters on the intranet via MattWeb and a browser; and the 
last third may run the original 6530/3270-sessions. With 
Screen Designer and MattWeb you may easily switch from one 
client interface to another. 

 
Figure 1.2: A Tandem application running on the Word Wide Web. 
The browser is Netscape Navigator. 

For further information on using Screen Designer with 
MattWeb, turn to the MattWeb Setup and Reference Guide. 
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MattOpen 
MattOpen 2.0 is composed of three independent development 
tools; MattOpen Dynamic Interface, Requester Replacer, and the 
DDE- and DLL statements of the Matterhorn Macro Language. 
When used optimally, these tools, together with the rest of the 
Matterhorn Suite - will make your Tandem system as open to 
new technologies as it will ever get. Using the tools of 
MattOpen 2.0 you may: 

! Access and control legacy Pathway applications on the 
Tandem from newer client applications on the PC. 

! Redirect requester calls from legacy Pathway 
applications to procedures in a Windows DLL. In 
effect, you replace  the entire requester with a DLL. The 
feature enables you to create and tailor new powerful 
applications without risking past investments. 

! Place calls in legacy Pathway applications to 
procedures in a Windows DLL. The DLL is called 
during the execution of a macro and the feature 
extends the functionality of the current requester 
enabling you for instance to retrieve values from a 
remote database or validate contents of fields. 

! Create and run macros in order to set up DDE 
conversations between your legacy Pathway 
applications and any DDE-compatible application. 

In short, the tools of MattOpen 2.0 provide gateways to and 
from legacy Pathway applications. Using MattOpen, Tandem 
customers may continue to create and add faster and more 
powerful client applications in programming languages like 
Borland Delphi, Microsoft Visual C++, Microsoft Visual Basic, 
Borland C++ or Pascal, or SmallTalk and integrate them with 
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their existing Pathway applications. Your legacy Pathway 
system may be integrated with new PC-based applications 
with a minimum of investment and risk. For further 
information on using MattOpen, turn to the MattOpen 
Developer´s Guide. 
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Chapter 1: 
Features of Screen Designer 

his chapter presents the many powerful features of 
Matterhorn Screen Designer. Each feature will be further 

detailed in chapters 4 through 6. 

The chapter is organized as follows: 

! Features of Screen Designer 

! Fonts and Colors 

! Buttons, Frames and Graphics 

! Backgrounds and Gradients 

! Multimedia and Tabbed Notebooks 

! Keyboard Mapping 

! Selection Lists and Entry Histories 

! Double-Click Actions and Hints 

! Matterhorn Macro Language 

! Data Explorer 

T
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Figure 1.1: Design your requester screens with Screen Designer. 

Features of Screen Designer 
Using Screen Designer you may customize requesters on many 
levels. With Screen Designer you may make cosmetic changes 
to the interface such as removing superfluous fields, grouping 
selected fields, and adding new text to make the screen more 
intuitive to the user. You may insert backgrounds such as 
wallpapers and gradients and set up multimedia objects to be 
played when the user runs the requesters. You may create and 
associate hints with each object. A hint is a guiding text that 
explains the purpose of that particular screen object. 

On a more functional level you may create and associate push 
buttons with function keys, macros, pictures, or multimedia 
clips. You may create macros and associate them with buttons, 
edit fields, pictures, and multimedia objects. Also, you may 



S c r e e n  D e s i g n e r  

 23

configure the requester to launch a macro as the user performs 
an accept of the screen, for instance when exiting or updating 
the requester or moving on to another requester. 

Using Screen Designer you may create and associate selection 
lists and entry histories with edit fields. In addition, you may 
map function keys. 

A new powerful feature in Screen Designer 5.0 is the ability to 
create tabbed notebooks. Tabbed notebooks enable you to 
organize the objects of a requester on separate tabs, just like 
most users know them from their Windows applications. 

Screen Designer allows you to customize legacy application 
screens for different groups of users or individual users. Using 
the same screen as a basis, you may create one screen for your 
bookkeeping department, another screen for the finance 
department and so on. Each requester screen will reflect how 
the current department operates. 

All the changes you may make to your legacy Pathway 
applications using Screen Designer will make functionality 
more discoverable and make common tasks simpler and more 
efficient. Consequently, Screen Designer increases end-user 
productivity. 

Fonts and Colors 
Using Screen Designer you may adjust the color and font 
settings for text, fields and push buttons. Also, you may 
change the sizes of fonts, fields, and graphics. Changing fonts, 
colors, and sizes are discussed in Chapter 4, Elements of 
Screen Designer and Chapter 6, Using Screen Designer. 
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Figure 1.2: Screen Designer enables you to change the font type, font, and 
color. 

Push Buttons 
Using Screen Designer you may create and associate push 
buttons with function keys to make the screens easier to 
navigate. 

Replacing function keys with buttons makes the screens 
mouse-driven as well as "keyboard-driven". This means that 
users no longer have to remember every keyboard routine, but 
simply click the button indicating the desired action. If, 
however, the user prefers to use the old function keys, these 
keys continue to work. In addition, Screen Designer allows 
you to define keyboard shortcuts, for instance Alt+C, that will 
perform particular actions. 
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Associating push buttons with function keys is discussed in 
Chapter 4, Elements of Screen Designer and in Chapter 6, 
Using Screen Designer. 

 
Figure 1.3: With Screen Designer you may replace function keys with push 
buttons. 

Frames 
In order to make a requester screen more organized you may 
group and frame fields or buttons that have similar meanings 
or purposes. In addition, you may assign various display 
effects to your frames. Working with frames is discussed in 
Chapter 4, Elements of Screen Designer and Chapter 6, Using 
Screen Designer. 
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Figure 1.4: Use Screen Designer to frame fields or buttons that are related 
or have similar meanings. 

Graphics 
Screen Designer allows you to insert graphic objects into your 
requester screens. For instance, you may insert your own 
images such as company logos or products to support the 
general perception of the screen. Working with graphic objects 
is discussed in Chapter 4, Elements of Screen Designer, and in 
Chapter 6, Using Screen Designer. 

Backgrounds and Gradients 
Using Screen Designer, you may customize the background of 
the requester and insert wallpaper and define gradient fills. 



S c r e e n  D e s i g n e r  

 27

Wallpapers and gradients fills do not exclude each other. 
Thus, you may have a gradient fill display behind a wallpaper 
image. Note that if the wallpaper covers the entire screen, the 
gradient will not display. This feature is discussed in Chapter 
4, Elements of Screen Designer and in Chapter 6, Using Screen 
Designer. 

 
Figure 1.5: With Screen Designer you may insert backgrounds to fashion 
your screens. 

Multimedia 
Use Screen Designer to insert multimedia clips in your 
Tandem requesters. A multimedia clip may for instance be 
played automatically as the user launches or exits the 
requester. Alternatively, the multimedia clip may be 
associated with a picture or a button and then played during 
the Matterhorn session as the user clicks the button or bitmap. 
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Screen Designer supports all MCI (Media Control Interface) 
extensions that your Windows version is able to handle. 

A video clip may either be executed within the Matterhorn 
session window or in a separate window. Working with 
multimedia clips is thoroughly discussed in Chapter 6, Using 
Screen Designer. 

 
Figure 1.6: With Screen Designer you may play multimedia clips from 
your Tandem requesters. 

Tabbed Notebooks 
A new powerful feature in Screen Designer 5.0 is the ability to 
create tabbed notebooks. Tabbed notebooks enable you to 
organize the objects of a requester on separate tabs, just like 
most users know them from their Windows applications. Not 
only do tabbed notebooks help you organize the objects of 
your requesters better. They do also provide more space on 
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the screen. By grouping the fields of a requester on separate 
tabs with meaningful titles, screens will appear less confusing 
to users. And the administrator who is in charge of designing 
screens will find it easy and fulfilling to work with tabbed 
notebooks. Tabbed notebooks are discussed in Chapter 4, 
Elements of Screen Designer and in Chapter 6, Using Screen 
Designer. 

 
Figure 1.7: With Screen Designer you may create tabbed notebooks to 
organize the objects of the requester better. 

Keyboard Mapping 
Screen Designer allows you to map your Tandem terminal 
keys. This feature enables you to use new client/server 
keyboard layouts without having to change the requester code 
in terms of what function keys activate which functions in 
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your legacy applications. For instance, you may map the SF16 
Tandem key (exit screen) to Esc on a Windows 95 keyboard. 
For many users, the Esc key has become the natural way of 
exiting a screen. 

Selection Lists 
With Screen Designer you may associate selection lists with 
your edit fields. 

A selection list is a fixed number of valid entries which can be 
used for a specific field. For instance, you may associate all 
valid zipcodes with a Zipcode field or all valid currency codes 
with a Currency Code field. When users right-click these 
fields, the valid values will be displayed in a dropdown list 
box. Associating a selection list with an edit field will ensure 
that users always select between valid values, preventing 
misspellings and other types of user input errors. Selection 
lists are discussed in Chapter 4, Elements of Screen Designer 
and in Chapter 6, Using Screen Designer. 
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Figure 1.8: Use Screen Designer to associate selection lists with 
edit fields. 

Entry Histories 
An entry history is a list of the entries, or inputs, most recently 
made for a particular edit field. When you activate the option 
for a field in Screen Designer, the entry history will be 
displayed when the user clicks the field during execution. This 
will save time if the user often makes the same entries in 
specific fields. 
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Figure 1.9: Use Screen Designer to associate entry histories with edit fields. 
When the user clicks the fields, the most recently used user inputs will be 
displayed in a dropdown list box. 

Using entry histories is a quite flexible way of streamlining 
user inputs. An entry history is saved on a per-user basis in 
the user’s personal Matterhorn initialization file. If, for 
instance, the same edit field appears in two different screens  
used by two different users (A and B) in two different 
departments (AA and BB), then two different entry histories 
will be generated. The entry history of user A will reflect his 
daily work, the entry history of user B will reflect her daily 
work. Entry histories are discussed in Chapter 4, Elements of 
Screen Designer and in Chapter 6, Using Screen Designer. 
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Hints 
Hints are guiding texts, which may be associated with edit 
fields. The text will be displayed when the user points the 
mouse cursor to the field. Use hints, for instance, to instruct 
users about the purpose of a field. Hints are discussed in 
Chapter 4, Elements of Screen Designer and in Chapter 6, 
Using Screen Designer. 

 
Figure 1.10: Use Screen Designer to associate hints with your edit field. 
The hint will be displayed when the user points the cursor to the field. 

Double-Click Actions 
Using Screen Designer, you may assign double-click actions to 
edit fields and multimedia objects. For instance, you may 
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associate an edit field with a function key or a macro and then 
assign a double-click to that edit field. When the user double-
clicks the field the function key (or macro) will be executed. 
When the user double-clicks a multimedia object, the 
multimedia clip will be executed. Double-click actions are 
discussed in Chapter 6, Using Screen Designer. 

Matterhorn Macro Language 
Using the Matterhorn macro language, you may create your 
own macros and run them in order to set up dynamic-data 
exchange (DDE) conversations with other applications that 
support DDE; either Matterhorn sessions and/or any number 
of DDE-compatible applications, including Word and Excel. 
Note that the macro statements which are used for for DDE 
and DLL require a MattOpen license. 

The Matterhorn macro language is an integral part of Screen 
Designer, which means that Screen Designer is the develop-
ment tool you use when creating macros. It is also from Screen 
Designer that you associate the macros with the objects of a 
requester. 

In this context, “associating” the macro with an object, refers 
to the process of relating the macro to either a button, an edit 
field, a multimedia object, a picture or the requester object. 
The user then activates the macro from the requester by 
clicking a button, entering certain data in an edit field, clicking 
a picture or a multimedia object, etc. 

Matterhorn macro language is the subject of Chapter 7, 
Matterhorn Macro Language but you will also find a thorough 
description in chapters 9 through 13 in the MattOpen 
Developer’s Guide. 
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Data Explorer 
The Data Explorer productivity tool provides a fast and easy 
way of monitoring and maintaining your Screen Designer 
databases on a large scale. Using Data Explorer you may 
create multiple requester layouts on the fly, preview your 
screens, and drag and drop selected objects from one requester 
to another requester and from one database to another 
database. In addition you may drag and drop entire requesters 
from one database to another. Data Explorer enables you to 
move from test to production in a matter of seconds. Data 
Explorer is part of your Screen Designer package. Read more 
in Chapter 8, Data Explorer. 

 
Figure 1.11: Data Explorer allows you to work with several open databases 
at a time. 
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Chapter 2: 
Installing Screen Designer 

his chapter takes you through the installation procedure 
of Screen Designer. Since this process is part of installing 

the Matterhorn Client, the chapter briefly repeats this 
procedure before it goes on to explain the creation of Screen 
Designer and Data Explorer icons and how to run the 
designed Pathway applications, i.e. requesters, as a 
Matterhorn session. 

The chapter is organized as follows: 

! The Screen Designer Package 

! System Requirements 

! Installing Screen Designer 

! Screen Designer and Matterhorn Profiles 

! Creating Profiles and Icons 

! Preparing a Screen Designer Session on Tandem 

! Summing Up 

! Running a Redesigned Requester 

T
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The Screen Designer Package 
Screen Designer is part of Matterhorn for Windows. It will 
automatically be instored, along with Data Explorer, when you 
select to install Matterhorn for Windows on the Matterhorn 
Suite CD-ROM. 

The CD-ROM also contains online user guides in PDF-format 
which you may load into Acrobat Reader or Acrobat 
Exchange, and subssquenly print on paper. 

System Requirements 
To install and use Matterhorn Screen Designer you need to 
install a licensed version of Matterhorn for Windows (the 
Matterhorn Pathway system and the Matterhorn Client). On 
PC, the following minimum requirements should be matched: 

System Minimum Recommended 

Processor 386 CPU 486 Mhz 

RAM 4 MB 8 MB 

Free disk space 3 MB  3 MB 

CSL or 

RSC 

 
Installed 

 
Installed 

Resolution 640x480 800x600 
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Likewise, the Matterhorn Pathway system, $SKYB, must be 
installed on the Tandem. $SKYB will maintain the link to 
those Pathway applications that have been set up as 
Matterhorn sessions. 

To install and run the Matterhorn Pathway system on 
Tandem, the following minimum system and software 
requirements should be matched: 

System Recommended 

Available disk space  3 MB 

Guardian  D20 or later 

Cobol Runtime Library  D20 or later 

RSC 

or 

CSL 

 C30 or later 

 

Version 1 

Scobol PATHTCP2  C21 or later 

MAXLINKMONS  > 0 

POBJ  Readaccess to POBJ 

 

The installation of the Matterhorn Pathway system is 
thoroughly described in the Matterhorn for Windows Setup 
and Reference Guide. 
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Note that Screen Designer and Matterhorn for Windows exist 
as both 16- and 32-bit applications. The 16-bit versions do not 
run at optimum performance on a Windows NT 4.0 platform.   

Installing Screen Designer 
Screen Designer is installed as part of installing the 
Matterhorn Client on PC. The Data Explorer productivity tool 
will also be installed on this occasion. 

Note that the installation process will not create Screen 
Designer or Data Explorer icons, but a Matterhorn Profile 
Utility icon. You must run the Matterhorn Profile utility to 
fully install Screen Designer. Turn to the section Creating 
Profiles and Icons later in this chapter. 

Running the InstallShield Wizard 
To install Screen Designer and Data Explorer: 

1. Insert the Matterhorn Suite CD-ROM in the CD-ROM 
drive. Select Run from the Start menu, locate the CD-
ROM and launch the Setup.exe file. 

2. In the opening screen, select Matterhorn for Windows. 
Matterhorn Installation will prepare the InstallShield 
Wizard, which will guide you safely through the 
installation process. 

3. When installation is complete, a Matterhorn folder 
containing a Matterhorn Profile Utility icon has been 
created. You must use this utility to work with Screen 
Designer and Data Explorer. 
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Screen Designer and Matterhorn Profiles 
Before we go on to explain how to create Screen Designer 
icons and use Screen Designer, you need to get familiar with 
the term Matterhorn profile. 

A Matterhorn profile is the initialization file which Screen 
Designer and the Matterhorn Client use at runtime. The profile 
informs the Matterhorn Client and Screen Designer with 
information necessary for addressing the Tandem system and 
executing the current session on PC. 

Screen Designer and the Matterhorn Client use identical 
versions of the same Matterhorn profile, but for two different 
purposes:  

• Basically, the Matterhorn profile tells Screen Designer 
which requesters may be loaded into Screen designer 
for redesigning. 

• When used by the Matterhorn Client, the profile 
informs the client which session to execute. 
Matterhorn will use the information in the Screen 
Designer database to display the redesigned versions 
of the requesters. 

Thus, in order to prepare Screen Designer for the connection 
with the Matterhorn Pathway system on Tandem and to 
inform the Matterhorn Client of which session to execute, the 
Matterhorn profile must be created and attached to the Screen 
Designer and Matterhorn executable files. This process is 
described in the following sections Creating Profiles and Icons 
and Working with Matterhorn Profiles. 

For more information about Matterhorn profiles, turn to 
Chapter 10, The Matterhorn Profile in the Matterhorn for 
Windows Setup and Reference Guide. 
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Creating Profiles and Icons 
When you are creating the icon needed for launching Screen 
Designer, part of the procedure involves the attachment of a 
Matterhorn profile to this icon. Both these tasks are managed 
in one go by using the Matterhorn Profile Utility. You can read 
more about Matterhorn profiles in a previous section. 

There are two similar approaches to creating profiles. You can 
either use the Profile Wizard or the advanced profile setup. 
Both approaches are more or less identical and both are 
available with the Matterhorn Profile Utility. In this manual 
we will only describe the Profile Wizard. The advanced profile 
setup is discussed in the Matterhorn for Windows Setup and 
Reference Guide. 

Note that Matterhorn and Data Explorer icons may also be 
created when you run the Matterhorn Profile Utility. 

Using the Profile Wizard 
The most simple way to create a new Matterhorn profile and 
attach it to Screen Designer is by using the Profile Wizard. You 
may also edit existing profiles with the wizard. 

To create or edit profiles with the Profile Wizard: 

1. Click the Matterhorn Profile Utility icon in your 
Matterhorn folder. 

2. Click the Profile Wizard button. The Profile Wizard 
starts. The wizard contains six windows, which 
prompts you for various types of information related 
to the Matterhorn profile and creating the icons. 

3. The first window is labeled Profile Name. Use this 
window to enter the name of the Matterhorn profile. If 



S c r e e n  D e s i g n e r  

 42

you wish to edit an existing profile, click the Browse 
button and locate the file. Click Next to continue. 

 
Figure 2.1: The Profile Name window. 

4. In the RSC Connection Information window, enter 
the filename of the relevant RSC initialization file (16- 
or 32-bit version) and the RSC section name. RSC 
forms the transport layer between the Tandem and the 
PC. Click Next to continue.  
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Figure 2.2: The RSC Connection Information window.  

5. In the Matterhorn Configuration Server window, 
specify where the Matterhorn configuration infor-
mation for each terminal is available. This path should 
lead to the Matterhorn Pathway system $SKYB, and 
the MATT-CONF server. The window contains the 
following fields: 

Session Name The unique name of the Screen 
Designer session (or Matterhorn 
session). This name is identical to the 
session name specified in Matterhorn 
Configuration, see the section 
Preparing a Screen Designer Session 
on Tandem later in this chapter. 

Matterhorn 
Tandem Node 

Name of your Tandem computer. 
The name has to match the Tandem 
setup. 

Matterhorn 
Pathway 
Monitor 

Name of the Matterhorn Pathway 
system. Unless you have changed 
the name of the Matterhorn Pathway 
system, use the default $SKYB. 
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Matterhorn 
Pathway 
Server 

Name of the Matterhorn confi-
guration server. Unless you have 
changed the name of the Matterhorn 
Configuration server, use the default 
MATT-CONF. 
 

When you have made your entries, click Next to 
continue. 

 
Figure 2.3: The Matterhorn Configuration Server window. 
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Figure 2.4: In the Icons window, select the icons to create. 

6. In the Icons window, select the icons to create. 
Matterhorn Profile Utility will create icons for 
Matterhorn, Screen Designer and Data Explorer. Also, 
type a relevant description for the icons. Click Next to 
continue. 

7. In the Select Program Folder window, indicate the 
folder in which to place the icons. 

8. The Profile Wizard will now create the icons. Click 
Finish to close the wizard. 

9. The icons are inserted in the specified program folder. 
To launch Screen Designer, click the Screen Designer 
icon. 
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Figure 2.5: The Select Program Folder window. 

10. If you wish to create additional icons, simply repeat 
the above procedure. 

Preparing a Screen Designer Session 
on Tandem 

In many ways, a Screen Designer session resembles a 
Matterhorn session. They both use the same Matterhorn 
profile and consequently use the same Session Name key to 
locate the relevant record in the MATT-CONF server on the 
Tandem. 

Unlike Matterhorn sessions, though, Screen Designer sessions 
do not display the screen indicated in the field Initial 
Requester of the Session Name in question. Instead, Screen 
Designer displays an empty application window. Once Screen 
Designer is running, you may open any requester that it may 
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locate using the POBJ search paths indicated in the POBJ 
Search Path window. 

 
Figure 2.6: The search paths indicated in the POBJ Search Path window 
determine which requesters may be loaded into Screen Designer. 

Other fields in Matterhorn Configuration, which are relevant 
to Screen Designer, is located in the Miscellaneous section 
(see also Figure 2.7):  

Use Screen 
Designer 
Layout 

Your choice for this field determines 
whether or not the users will see the 
designed version of the requester when the 
requester is executed. Options for the field 
are Yes and No. You must choose Yes in this 
field, both when you wish to run Screen 
Designer and when you wish to run the 
requester with the designed screen. 
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Screen 
Designer 
Group Name 

In this field, enter the name of the user 
group that will use the current layout. You 
can create up to 7 different screen layouts 
based on the same requester. For instance, 
you may create one layout for the finance 
department, another layout for the 
accounting department, etc. You may use 
up to 8 characters for a group name. 

 
Figure 2.7: Use the Miscellaneous section to enter information necessary 
to run Screen Designer. 

Screen 
Designer 
Database 
Location 

Use this field to indicate the location of the 
Screen Designer database. The database may 
be located either on Tandem or on PC. Note 
that you cannot design requesters if you 
have not indicated a path to a database. 
There is no limit as to the number of 
requesters that may be handled by the same 
database. 
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You must enter a path to a database in this 
field before you can design requesters with 
Screen Designer. Screen Designer will create 
the database the first time you run Screen 
Designer. 

Summing Up 
This section sums up the stages involved when creating a 
Screen Designer session. 

On PC 
• Use the Matterhorn Profile utility to create and attach 

a Matterhorn profile to the relevant Matterhorn and 
Screen Designer icons. The Session Name indicated in 
the profile must also exist as a session in Matterhorn 
Configuration. 

On Tandem 
• In Matterhorn Configuration, the Session Name in 

question must contain valid POBJ search paths leading 
to the requesters you wish to open and redesign. 
Check the POBJ Search Path window to verify or 
change these settings. 

• In Matterhorn Configuration, the Session Name in 
question must contain valid entries in the fields Use 
Screen Designer Layout, Screen Designer User 
Group, and Screen Designer Database Location. 
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Running a Redesigned Requester 
To run the Windows version of the Tandem requesters, click 
the related Matterhorn session icon. The Matterhorn Client 
will visualize the session in accordance with the changes you 
have made to the requesters with Screen Designer. 

 
Figure 2.8: Preview your applications before use. 
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Chapter 3: 
How Does Screen Designer Work 

his chapter is intended to explain the operation of Screen 
Designer. The chapter will illustrate the interaction of 

Screen Designer and Matterhorn Client. 

The chapter is organized as follows: 

! Matterhorn and Screen Designer 

! Screen Designer Objects 

! The Screen Designer Database 

! Operation Flow 

 

T
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Matterhorn and Screen Designer 
Screen Designer is designed to extend Matterhorn for 
Windows. You cannot use Screen Designer without having 
implemented Matterhorn on your system. 

As you have already learned, Matterhorn for Windows makes 
your Tandem system completely open to the client/server 
technology. The Matterhorn Client transfers the object code of 
the requester from the Tandem POBJ to the PC and executes it 
from here. This means that the PC is entirely in control of the 
user interfaces and that computing technologies like DDE-
conversation, DLLs, and multimedia will be available to your 
Pathway applications. 

 
Figure 3.1: In Screen Designer, requester screens will be displayed in the 
main area. Each screen element is considered an object. 
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When you are working with Screen Designer, the program 
copies the screen section of the requester’s object code to the 
PC and displays it in a template application window. In this 
window, as you will see in later chapters of this manual, you 
may manipulate each screen object on various levels. 

Screen Designer Objects 
When you open a Pathway requester in Screen Designer, the 
requester will be displayed in a template application window 
exactly as were it being executed as a Matterhorn session. If 
you have never run the requester as part of a Matterhorn 
session this will give you an idea of how it will be executed 
under Matterhorn. 

As you will learn, the term object is a core term in Screen 
Designer. The basic objects are edit fields (known as fields on the 
Tandem) and text fields (known as fillers on the Tandem). In 
addition, you may use Screen Designer to add new objects to 
your screens, including frames, panels, push buttons, graphics, 
multimedia objects, and tabbed notebooks. 

Another important object in Screen Designer is the requester 
object. The requester object is the background on which all 
other objects are placed. Each requester has got but one 
requester object. You cannot delete the requester object or 
create new requester objects with Screen Designer. 

The Screen Designer Database 
When using Screen Designer you create and relate a database 
of information to the object code of your Tandem requesters. 
The database will store information about advanced screen 
layout, available selection lists, macros etc. Subsequently, 
Matterhorn will use the information in the database when 
displaying the screen during a Matterhorn session. 
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Note that you must indicate a path to the Screen Designer 
database before you can redesign your requesters. This path is 
specified in the Miscellaneous section of the Matterhorn 
Configuration program; more precisely in the field Screen 
Designer Database Location. Screen Designer databases may 
be located either on the Tandem or on the PC. 

Data Explorer 
The Data Explorer productivity tool provides a fast and easy 
way of monitoring and maintaining your Screen Designer 
databases on a large scale. Using Data Explorer, you may 
create multiple requester layouts on the fly, preview your 
screens, and drag and drop selected objects from one requester 
to another requester, from one database to another database. 
Data Explorer enables you to move from test to production in 
a matter of seconds. Data Explorer is part of your Screen 
Designer package. Read more in Chapter 8, Data Explorer. 

Operation Flow During a Matterhorn 
Session  

This section is intended to explain the operation and 
interaction of the Matterhorn Client, the Matterhorn Pathway 
system, and the Screen Designer database at runtime. The 
most appropriate way to do this is to illustrate what happens 
from the point when the user clicks a Matterhorn session icon 
in Windows, to the time a few seconds later when the Tandem 
requester is displayed on his or her screen. 

Each Matterhorn session is identified by an icon in your 
Matterhorn program group. When you double-click a 
Matterhorn session icon, the following actions will take place: 
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1. Windows will execute the command line associated 
with the icon. For instance: 
 
C:\Matt\Mattwin.exe C:\Matt\Mattwin.ini 
 
The line tells Windows to launch the Matterhorn 
Client program file Mattwin.exe, which is located in 
the directory C:\Matt. 

2. The Matterhorn profile is crucial to the Matterhorn 
Client. It provides Mattwin.exe with five important 
pieces of information: 1) a pointer to RSC. (RSC 
establishes and maintains the communication between 
the PC and the Tandem system); 2) the name of the 
Tandem system on which Matterhorn is located; 3) the 
name of the Matterhorn Pathway system to address; 4) 
the Matterhorn server holding the configuration 
settings for the current session; and, finally, 5) the 
Session Name, a unique reference to the current 
session on the Tandem. 

 

 

 

 

 
 

 

Figure 3.2: The Matterhorn profile provides the Matterhorn 
Client with information necessary for addressing the Tandem 
system. 

 
[CONFIG] 
RscFile=C:\RSC\RSC.INI 
RscFile32=C:\RSC32\RSC.INI 
RscSection=RSC 
System=\TANDEM 
Pathmon=$SKYB 
Server=MATT-CONF 
SessionName=DALMORE 
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3. With the information from the profile at hand, the 
Matterhorn Client first establishes the connection to the 
Tandem via RSC. 

4. Next, the Matterhorn Client addresses the Tandem 
system and requests the MATT-CONF server for the 
information related to the session indicated by the 
Session Name (see Figure 3.3). This information is 
stored in a unique record. This record provides the 
Matterhorn Client with the information necessary to 
address the session on Tandem, including the search 
path of the POBJ requester environment and the initial 
requester. Also, information about UMP-handling and 
how the requester should be displayed when running 
under Windows will be made available to Matterhorn 
at this point. If the record also informs that Screen 
Designer layout should be used for this requester and 
the path for the associated Screen Designer database, 
the Matterhorn Client will register this information. 

Session Name
Initial
Requester
POBJ

Session Name
Initial
Requester
POBJ

Session Name
Initial
Requester
POBJ

Session Name
Initial
Requester
POBJ Location
UMP Info

Matterhorn Client
running on PC

Remote Server Call

MATT-CONF

Configuration Server

PC Pathway System $SKYB

Database of Matterhorn
session information

 

Figure 3.3: The Matterhorn Client consults the MATT-CONF 
server for information about which session to execute and how. 
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5. The Matterhorn Client then consults the MATT-POBJ 
server for the location of the POBJ and the name of the 
initial requester. The requester source code will be 
identified and transferred to the PC. 

6. Finally, the Matterhorn Client will interpret and 
execute the requester on the user’s PC. If Matterhorn 
has been instructed to use a Screen Designer layout, it 
will consult the Screen Designer database at this point 
and search for the name of the current requester. If a 
match is found, Matterhorn will display the screen 
according to the contents of the database. 

Matterhorn Client
running on PC

Remote Server Call

MATT-POBJ

POBJ Server

POBJ

PC Pathway System $SKYB

Screen Designer
Database

 
Figure 3.4: The Matterhorn Server MATT-POBJ will locate and 
submit the requester’s object code to the Matterhorn Client. After 
having consulted the Screen Designer database, the Matterhorn Client 
will visualize the screen. 
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Chapter 4: 
Elements of Screen Designer 

his chapter will familiarize you with the components of 
the Screen Designer application window. The user 

interface is described in detail and you will learn about using 
both the mouse and the keyboard. 

The chapter is organized as follows:  

! The Screen Designer Application Window 

! The Menus 

! The Tool Bar 

! The Object Inspector 

! Format Painter 

T
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The Screen Designer Application Window 
Figure 4.1 depicts the Screen Designer application window. 
This window is the work place when designing requester 
screens. Note that all screen shots in this manual have been 
shot under Windows 95. 

The Screen Designer application window consists of the main 
work area, the menu bar, the tool bar, and the canvas. The 
various menu options are described in detail in the section The 
Menus. The tool bar is discussed in the section The Tool Bar. 

You may resize the application window to fit your demands. 
To change the size, drag the window border. Note that the size 
of the requester will always be fixed. As you enlarge the 
window, a canvas will be displayed. 
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Figure 4.1: The Screen Designer application window. 

Please note that the general operation of the Windows user 
interface is described in your Windows documentation and 
will not be repeated here. Your Windows documentation 
describes the general conventions of the Windows Graphical 
User Interface (GUI) such as operation of the pull-down 
menus, selection of file names, and operation of dialog boxes. 

The Main Work Area 
The main work area is the large blank area you use to design 
your requester screens.  
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Figure 4.2: Requester screens will be displayed in the main area. 

The Title Bar 
The title bar displays Matterhorn Screen Designer along with the 
name and screen number of the requester currently loaded. To 
move the Screen Designer application window, point the 
mouse cursor to the title bar and drag. 

The Menu Bar 
The menu bar runs just below the title bar. The menu bar 
holds all of Screen Designer’s pull-down menus that will help 
you to open, fashion, optimize and save your requester 
screens. The section The Menus in this chapter describes the 
operation of each menu and menu option. In Chapter 6, Using 
Screen Designer, you will find an in-depth discussion of the 
application of each menu option. 
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Figure 4.3: The Screen Designer menu bar. 

The Tool Bar 
The tool bar runs just below the menu bar. The tool bar 
consists of icons each representing a tool or option which you 
can use when screen designing. The section The Tool Bar in 
this chapter describes the operation of each icon in the tool 
bar. In Chapter 6, Using Screen Designer, you will find a 
thorough discussion of the application of each icon in the tool 
bar. 

 
 

 
Figure 4.4: The Screen Designer tool bar. 
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The Canvas 
As mentioned, you may resize the Screen Designer application 
window. Enlarging the window will display the canvas area 
(see Figure 4.5). 

 
Figure 4.5: Use the canvas as a temporary working area when designing 
tabbed notebooks. 
Use the canvas as a working area when creating and 
formatting tabbed notebooks or other large objects. Gridlines 
will continue to show on the canvas. 

Note that the canvas works as a temporary working area. You 
cannot save a requester if its objects are still located on the 
canvas. To move an object to the canvas, select the object and 
drag it with the mouse. 
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The Menus 
This section takes you through the menus and menu options of 
the Screen Designer menu bar. 

The File Menu 
The File menu controls the flow of information into and out of 
Screen Designer. The File menu provides five different 
options:  

! Open Requester 

! Save Requester 

! Save Requester in Group 

! Select Group 

! Show Messages 

! Launch Data Explorer 

! Exit 

! Recent File List 



S c r e e n  D e s i g n e r  

 65

 

Figure 4.6: The File menu. 

Open Requester 
To open a requester, select Open Requester from the File 
menu. In the Open Requester dialog box, enter the name of 
the requester in the Requester Name field and, if relevant, the 
appropriate screen number in the Screen Number field. If you 
do not enter a screen number, Screen Designer will select 
screen number 1. Click the OK button to load the requester. 
The requester name and screen number will appear from the 
title bar while the requester is loaded. 

Please note that you may only work with one requester at a 
time. 
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Figure 4.7: The Open Requester dialog box. 

Save Requester 
To save the requester, select Save Requester from the File 
menu. The requester will be saved under the name shown in 
the title bar.  

Information about your modifications to the screen layout will 
be saved in a separate database. The next time you run the 
requester, the Matterhorn Client will use this information to 
display the screen. 

Save Requester in Group 
Use this command to save the current requester in a different 
user group. In the Save Requester in Group dialog box, select 
the group in which you wish to store the requester. Note that 
you can also create new groups from this dialog box, and that 
two or more user groups cannot have identical names. 

Select Group 
To select or create a new group, pick Select Group from the 
File menu. In the Database Groups dialog, type the name of 
the group or select the name of an existing group. Note that 
two or more user groups cannot have identical names.  
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Show Messages 
This option will display error messages from the Tandem. The 
window corresponds to the Messages window that will 
sometimes be displayed during a Matterhorn session. 

Launch Data Explorer 
To launch Data Explorer from Screen Designer, select Launch 
Data Explorer from the File menu. Data Explorer is further 
detailed in Chapter 8, Data Explorer.  

Exit 
To exit Screen Designer, select Exit from the File menu. 

Recent File List 
At the bottom of the File menu you will see the names of the 
four most recently loaded requesters. Select the name with the 
mouse to open the requester. 

The Edit Menu 
Using the commands in the Edit menu you may undo and 
redo lasts actions, cut, copy, paste and delete object, and select 
objects by their type. The Edit menu provides these options:  

! Undo 

! Redo 

! Restore Object 

! Cut 

! Copy 
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! Paste 

! Delete 

! Select Object 

! Select All 

Undo 
Select this command to undo your last action. Alternatively, 
press Ctrl+Z or click the Undo button. 

Redo 
Select this command to redo your last undo action. 
Alternatively, press Shift+Ctrl+Z or Shift+Alt+Backspace or 
press the Redo button. 

Restore Objects 
To restore deleted objects, select Edit, Restore Object. This 
will open the Restore Objects window. Highlight the object(s) 
you wish to restore and click OK. 

Cut 
Use this command to cut the selected object(s) from Screen 
Designer and place them on the Clipboard. Alternatively, 
press Ctrl+X or Shift+Delete. Objects which have been cut, 
may be inserted into another requester. 

Copy 
Use this command to copy the selected object(s) to the 
Clipboard. Alternatively, press Ctrl+C or Ctrl+Insert. Copy 
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may be used, for instance, to copy objects from one requester 
to another. 

Paste 
Use this command to paste the contents of the Clipboard into 
the Screen Designer main area. Alternatively, press Ctrl+V or 
Shift+Insert. You cannot paste edit fields. 

Delete 
Use this command to delete the selected object(s). 
Alternatively, press Ctrl+Delete or simply Delete. As a rule, 
the deletion will not be permanent until you save the 
requester. Until then, the objects may still be accessed and 
restored from the Restore Objects window. Note that this rule 
does not apply to text objects and edit fields. These objects 
may still be restored after you have saved the requester. 

Select Object 
Use this options to select all objects of the same type. For 
instance, to select all text objects, select Edit, Select Object, 
Text. For further information on selecting objects in Screen 
Designer, turn to the section Selecting an Object in Chapter 5, 
Screen Designer Objects. 

Select All 
Use this command to select all objects on the screen. The 
option is useful, for instance if you wish to move all objects on 
screen at the same time. For further information on selecting 
objects in Screen Designer, turn to the section Selecting an 
Object in Chapter 5, Screen Designer Objects. 
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The Object Menu 
Each screen element in the main work area is referred to as an 
object. Thus, an object may be either a text object, an edit field, 
a button, a picture, a frame, a multimedia clip or a tabbed 
notebook. 

Another important object in Screen Designer is the requester 
object. The requester object is the background on which all 
other objects are placed. Each requester has got but one 
requester object. You cannot delete the requester object or 
create new requester objects with Screen Designer, but you 
may customize it on various levels. 

Apart from edit fields and the requester object, all other 
objects may be created using the Object menu. Once in the 
main area, each type of object may be subject to different 
forms of formatting. 
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Figure 4.8: The Object menu. 

The Object menu provides the following options: 

! Insert Text 

! Insert Button 

! Insert Picture 

! Insert Frame 

! Insert Multimedia 

! Insert Tabbed Notebook 
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Insert Text 
To insert a new text object, select Insert Text from the Object 
menu. The text object will be inserted in the centre of the main 
work area. The Object Inspector to the right of the Screen 
Designer application window will display a set of default 
properties related to the object. You may now use the Object 
Inspector to format the text object on various levels. Finally, 
use the mouse to drag the object to the desired location. For 
more information about working with text objects, turn to 
Chapter 6, Using Screen Designer. 

 
Figure 4.9: A text object has been inserted in the centre of the main area. 
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Figure 4.10: Use the Object Inspector to 
format the text object. 

Insert Button 
To insert a new button and associate it with a function key, a 
macro, a multimedia clip or - if you are using MattWeb - an 
URL, select Insert Button from the Object menu. The button 
will be inserted in the centre of the main work area. The Object 
Inspector to the right of the Screen Designer application 
window will display a set of default properties related to the 
button. You may now use the Object Inspector to format the 
button on various levels. Finally, use the mouse to drag the 
button to another location. For more information about 
working with buttons, turn to Chapter 6, Using Screen 
Designer. 
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Figure 4.11: Use the Object Inspector to 
format the button. 

Insert Picture 
To import a graphic image, select Insert Picture from the 
Object menu. A blank picture object will be inserted in the 
centre of the main work area. The Object Inspector to the right 
of the Screen Designer application window will display a set 
of default properties related to the picture. In the Object 
Inspector, click the Filename property to open the Open 
Picture dialog box. In the Open Picture dialog box, locate the 
desired image. Screen Designer supports the following graphic 
formats; GIF, JPG, PCX, BMP, TIF and PNG. Click the OK 
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button to associate the image with the picture object. Back in 
the Object Inspector, format the picture on various levels. 
Finally, use the mouse to drag the picture object to another 
location. For more information about working with graphic 
images, turn to Chapter 6, Using Screen Designer. 

 
Figure 4.12: The Open Picture dialog box. 

Insert Frame 
To insert a frame, select Insert Frame from the Object menu. 
A blank frame object will be inserted in the centre of the main 
work area. The Object Inspector to the right of the Screen 
Designer application window will display a set of default 
properties related to the frame. Use the Object Inspector to 
format the frame on various levels. Finally, use the mouse to 
drag the button to another location. For more information 
about working with frames, turn to Chapter 6, Using Screen 
Designer. 
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Insert Multimedia 
To insert a multimedia object, select Insert Multimedia from 
the Object menu. A blank multimedia object will be inserted 
in the centre of the main work area. The Object Inspector to the 
right of the Screen Designer application window will display a 
set of default properties related to the multimedia object. Use 
the Object Inspector to assign a multimedia file to the object 
and to set other properties related to the appearance of the 
multimedia clip when played. For more information about 
working with multimedia, turn to Chapter 6, Using Screen 
Designer. 

Insert Tabbed Notebook 
To insert a tabbed notebook, select Insert Tabbed Notebook 
from the Object menu. A blank tabbed notebook object will be 
inserted in the centre of the main work area. The Object 
Inspector to the right of the Screen Designer application 
window will display a set of default properties related to the 
object. Use the Object Inspector to determine the number of 
tabs on this notebook, give them meaningful titles and 
customize them on various levels. For more information about 
working with tabbed notebooks, turn to Chapter 6, Using 
Screen Designer. 

The Define Menu 
The Define menu enables you to define entry histories, 
selection lists and create simple macros. It is also from the 
Define menu that you map function keys and work with the 
powerful feature Requester Replace. Entry histories and 
selections list are thoroughly discussed in Chapter 6, Using 
Screen Designer. The Matterhorn macro language is discussed 
in Chapter 7, Matterhorn Macro Language and in the 
MattOpen Developer’s Guide. 
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Figure 4.13: The Define menu. 

 The Define menu provides the following options: 

! Entry Histories 

! Selection Lists 

! Macro 

! Requester Replace 

! Keyboard Mapping 

 

Entry History 
An entry history is a list of the entries, or inputs, most recently 
made for a particular edit field. When the user right-clicks the 
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field during a Matterhorn session, the entry history will be 
displayed. This will save time if the user often makes the same 
entries in specific fields. 

Using entry histories is a quite flexible way of streamlining 
user inputs. An entry history is saved on a per-user basis in 
the user’s personal Matterhorn initialization file. If, for 
instance, the same edit field appears in two different screens, 
used by two different users (A and B) in two different 
departments (AA and BB), then two different entry histories 
will be generated. The entry history of user A will reflect his 
daily work, the entry history of user B will reflect her daily 
work. 

 
Figure 4.14: Use the Entry History dialog box to create entry 
histories. 

To define an entry history, select Define, Entry History. This 
will open the Define Entry History dialog box. In this dialog 
box, you may enter a relevant name that reflects the name and 
purpose of the field to which the entry history is intended to 
be associated with. 
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For further information about associating entry histories with 
edit fields, turn to Chapter 6, Using Screen Designer. 

Selection Lists 
A selection list is a fixed number of valid entries which can be 
used for a specific field. For instance, you may associate all 
valid zipcodes with a Zipcode field or all valid currency codes 
with a Currency Code field. When users right-click these 
fields, the valid values will be displayed in a dropdown list 
box. 

 
Figure 4.15: The Edit Selection List dialog box. 

To create a selection list, choose Selection Lists from the 
Define menu. In the Selection Lists dialog box you may either 
create a new selection list by entering a new name in the field 
List Name and pressing the Create button, or edit an existing 
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selection list by choosing it from the list and pressing Edit. In 
the Edit/Create Selection List dialog box, the field Value 
Source allows you either to create the selection list manually 
or - to save time - to import it from a text file, to request it from 
your Tandem Pathway server or to load the list by specifying a 
path to a DLL. In the field Base List On you may select the 
name of an existing selection list on which to base the new 
selection list. 

For more information about working with selection lists, turn 
to Chapter 6, Using Screen Designer. 

Macro 
To create a macro, select Macro from the Define menu. This 
will open the Macro dialog box. In the Macro dialog box you 
may either create a new macro by entering a new name in the 
field Macro Name and pressing the Create button or edit an 
existing macro by choosing it from the list and press Edit. In 
the Create Macro dialog box (see Figure 4.16), enter the 
contents of the macro in the field Macro Description. You will 
learn more about macros in Chapter 7, Matterhorn Macro 
Language. 

The macro may subsequently be associated with an object of 
the requester. 
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Figure 4.16: The Edit/Create Macro dialog box 

Requester Replace 
Using Screen Designer together with MattOpen you may 
redirect requester calls from the current requester to a 
procedure in a Windows-DLL. This feature, called Requester 
Replace, opens up your Tandem system to the powerful and 
flexible DLL-technology. Note that the Requester Replace 
option will only operate if you have also implemented 
MattOpen on your system. 

The menu option will be dimmed if you have not 
implemented MattOpen on your system. For more 
information, turn to the MattOpen Developer’s Guide. 

Keyboard Mapping 
Screen Designer enables you to map your Tandem terminal 
keys to PC-keys. If, for instance, it makes more sense to use 
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Esc to exit an application than SF16, you may use this feature 
to map the function key SF16 to the Esc-key.  

 
Figure 4.17: Use the Key Map dialog box to map terminal keys. 

To change the current terminal keyboard mapping, select 
Keyboard Mapping from the Define menu. This will produce 
the Key Map dialog box (see Figure 4.17). If you are using 
65xx terminals, the column in the left side of the dialog box 
will be entitled 65xx Terminal Keys; if you are using 3270 
terminals it will be entitled 3270 Terminal Keys. 

To assign a PC-key to a terminal key, locate and select the 
terminal key in the left column. Then press the key or 
keyboard combination on your keyboard. Finally, click the 
Map button. 

In the Key Map dialog box the following buttons are available: 

Map To map the selected terminal key, click the 
Map button 
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Unmap To unmap the selected terminal key, click the 
Unmap button. 

Default Map To restore all mappings to the default 
mapping, click the Default Map button. 

Unmap All To unmap all terminal keys, click the Unmap 
All button. 

Print To print the current key mapping, click the 
Print button. 
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The Options Menu 
In the Options menu you will find a series of tools which will 
help you format your objects and create more accurate screens. 

The Options menu provides the following options: 

! Inspector 

! Preferences 

! Redraw 
 

 
Figure 4.18: The Options menu. 
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Inspector 
Screen Designer objects are formatted by means of the Object 
Inspector. The Object Inspector displays all properties of the 
currently selected object(s) like fonts, size, on-screen position, 
etc. in a separate window. It is also from the Object Inspector 
that you customize the functionality of the various objects such 
as associating function keys, macros and multimedia clips 
with push buttons or picture objects. 

 
Figure 4.19: The Object Inspector showing 
text object properties. 

The contents of the Object Inspector vary with the object type. 
In Figure 4.18, the Object Inspector is displaying text object 
properties. Use the Object Inspector to format your objects. If, 
for instance, you wish to change the font of a text object, 
highlight the Font property in the Object Inspector and click 
the button to the right of the Font property to open the Font 
dialog box. Select the new font and click OK. The Object 
Inspector is further detailed in Chapter 6, Using Screen 
Designer. 
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To deactivate or activate the Object Inspector, select Options, 
Inspector or press F11. 

Preferences 
The Preferences dialog box provides access to various options 
related to the way Screen Designer performs as you are 
redesigning requesters. From the Preferences dialog box you 
may, for instance, indicate the selection mode of Screen 
Designer, set the grid options, and select a default font to be 
used for new objects. 

Note that the changes you make in the Preferences dialog box 
will be saved as part of Screen Designer’s own configuration. 

To open the Preferences dialog box, select Options, 
Preferences. The dialog box contains a Layout tab and a 
Default Font tab: 

 
Figure 4.20: The Layout tab of the Preferences dialog box. 
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The Layout tab provides the following options: 

Show Grid Select this option to display the 
gridlines when designing your 
screens. 

Snap to Grid With this option checked, objects will 
be snapped to the nearest gridline or 
intersection of gridlines. The 
gridlines will not be displayed if you 
have not checked the Show Grid 
option. 

Grid Size X Use this field to indicate the width of 
the grid. The unit of measurement is 
pixels. Default is 8 pixels. 

Grid Size Y Use this field to indicate the height 
of the grid. The unit of measurement 
is pixels. Default is 8 pixels. 

Show Occurs 
Fields 

Use this option if your requesters 
contain one or several occurs fields, 
i.e. fields that are replicated on the 
screen. Show Occurs will display all 
occurrences of the fields to avoid 
you from inserting objects in the 
wrong places by mistake or from 
moving the occurs field(s)  to places 
where they won’t fit. 
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Figure 4.21: The field Session Name is an occurs field. To display 
all occurrences of the field, check the Show Occurs Fields check box. 
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Figure 4.22: The Show Occurs Fields option makes Screen 
Designer display all occurrences of an occurs field. 
 

Show Wallpaper If you have selected a wallpaper for 
the requester object, it may be a 
tiresome affair to wait for the screen 
to update as you are redesigning the 
requester. Consequently, it makes 
sense to deactivate the wallpaper 
while you are adding the finishing 
touches to the screen. Clear the check 
mark in this check box to deactivate 
the wallpaper. 

Enclose Objects Screen Designer has two different 
selection modes for selecting 
multiple objects: enclose mode and 
touch mode. 
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If the Enclose Objects check box is 
checked, the selection line indicating 
the selected area must be clear of the 
objects you wish to select. 

Touch Objects If the Touch Objects check box is 
checked, the selection line merely 
has to touch the objects you wish to 
select.  

 
Figure 4.23: The Default Font tab of the Preferences dialog box. 
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In the Default Font tab you may select a default font face and 
set various font attributes, which will be used when creating 
new objects. The tab contains the following options: 

Font Name Select a font face from the list. This 
font will be used for all new objects. 

Size Select a size from the list. This font 
size will be used for all new objects. 

Style Select a font style from the list. This 
font style will be used for all new 
objects. Options are Normal, Bold, 
Italic, and Bold Italic. 

Color Select a font color from the list. This 
color will be used for all new objects. 
The available colors depends on 
your Windows version. 

Sample In the Sample field you can see how 
the selected font will appear in 
Screen Designer and later when the 
requester is executed by the 
Matterhorn Client. 

Activate FontUse This option lets you configure in 
what manner the default font is used 
during the design phase. 

Check this option to use and display 
the selected default font for new 
objects. In the Object Inspector, the 
FontUse property will be set to True. 

Remove the marking if you wish to 
use the default font on new objects 
but not actually display it. In the 
Object Inspector, the FontUse 
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property will be set to False. When 
you set the property to True, the 
default font will be displayed. 

Activate 
FontColorUse 

This option lets you configure in 
what manner the default font color is 
used during the design phase. 

Check this option to use and display 
the selected default font color for 
new objects. In the Object Inspector, 
the FontColorUse property will be 
set to True. 

Remove the marking if you wish to 
use the default font color on new 
objects but not actually display it. In 
the Object Inspector, the 
FontColorUse property will be set to 
False. When you set the property to 
True, the default font will be 
displayed. 

Redraw 
As you design requester screens with the Show Grid option 
activated, the gridlines occasionally disappear. Use Options, 
Redraw to update the grid. 

The Help Menu 
Screen Designer’s built-in online help is a fast and convenient 
way to search for information about specific features or tasks. 
The Help system is a traditional and standardized Windows 
help system. For more information about using Help, turn to 
your Microsoft Windows User’s Guide. 
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The Tool Bar 
The tool bar runs just below the menu bar. For your 
convenience, you may use these tools instead of the menu 
options. The following pages merely provide brief descriptions 
of the tool buttons. For a more in-depth discussion of the 
application of each button and how to use it, turn to Chapter 6, 
Using Screen Designer. 

 
 

 
Figure 4.24: The Screen Designer tool bar. 

These are the tool buttons in Screen Designer: 

! Open Requester 

! Save Requester 

! Select Object 

! Format Painter 

! Insert Text 

! Insert Button 

! Insert Picture 

! Insert Frame 

! Insert Multimedia 

! Insert Tabbed Notebook 
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! Cut 

! Copy 

! Paste 

! Undo 

! Redo 

! Restore Objects 

! Redraw 

 

Open Requester To load a new requester, click Open 
Requester. This will activate the Open 
Requester dialog box. Enter the name of 
the requester and the relevant screen 
number and click the OK button. If you 
click Open Requester while you are still 
working with another requester, you will be 
prompted to save the current requester 
before loading the new one. 

Save Requester To save the current requester, click the 
Save Requester button. 

Select Object Clicking this button puts you into selection 
mode. In selection mode, the mouse pointer 
changes to an arrow so you can select 
objects on the screen. You can use the 
selection pointer to click objects or to drag a 
selection rectangle around multiple objects 
to select them. When several objects are 
selected you may use the Object Inspector 
to format all selected objects. 

Note that Screen Designer has two different 
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selection modes for selecting multiple 
objects, enclose mode and touch mode. These 
modes are controlled from the Layout tab 
in the Preferences dialog box. See the 
section Selecting Multiple Objects in 
Chapter 5, Screen Designer Objects. 

If the Enclose Objects check box in the 
Layout tab is checked, the selection line 
indicating the selected area must be clear of 
the objects you wish to select. 

If the Touch Objects check box in the 
Layout tab is checked, the selection line 
merely has to touch the object you wish to 
select. 

Format Painter When the Format Painter tool is active you 
may copy formats from selected objects to 
objects you wish to format the same way. 
If, for instance, your requester contains a 
text object with a certain font and 
background color, you may use Format 
Painter to copy the format of this object to 
other objects. 

Note that not all properties may be copied. 
The object properties which can be copied 
will appear with a green text color in the 
Object Inspector. For more information on 
the Format Painter tool, turn to the section 
Format Painter in this chapter. 

Insert Text To insert a text object, click the Insert Text 
button. For more information about 
creating and formatting text objects, turn to 
Chapter 6, Using Screen Designer. 
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Insert Button To insert a new button and associate it with 
a function key, macro or multimedia clip, 
click Insert Button. For more information 
about creating and formatting buttons, turn 
to Chapter 6, Using Screen Designer. 

Insert Picture To insert a graphic image and associate it 
with a function key or multimedia clip, 
click the Insert Picture button. For more 
information about creating and formatting 
pictures, turn to Chapter 6, Using Screen 
Designer. 

Insert Frame To insert a frame, click the Insert Frame 
button. For more information about 
creating and formatting frames, turn to 
Chapter 6, Using Screen Designer. 

Insert 
Multimedia 

To insert a multimedia clip, click the Insert 
Multimedia button. For more information 
about creating and formatting multimedia 
objects, turn to Chapter 6, Using Screen 
Designer. 

Insert Tabbed 
Notebook 

To insert a tabbed notebook, click the Insert 
Tabbed Notebook button on the tool bar. A 
blank tabbed notebook object will be 
inserted in the centre of the main work 
area. For more information about working 
with tabbed notebooks, turn to Chapter 6, 
Using Screen Designer. 

Undo To undo the last action, click the Undo 
button. If you wish to undo several actions, 
click the small arrow next to the Undo 
button. Screen Designer will then display a 
window containing the last actions 
performed (up to 100). Use the mouse to 
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select the actions you wish to undo. 

Redo To reverse the action of the Undo button, 
click the Redo button. 

Restore Objects To restore objects that you have previously 
deleted from the main work area, click the 
Restore Objects button. For more informa-
tion about restoring objects, turn to Chapter 
6, Using Screen Designer. 

Redraw To redraw the screen, click the Redraw 
button. 
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Figure 4.25: The Restore Objects window. 

The Object Inspector 
Use the Object Inspector to format your objects in Screen 
Designer. The Object Inspector is a separate window that will 
display all properties of the currently selected object. 

The Object Inspector also enables you to format multiple 
objects at a time. Even objects of different types. Simply select 
the objects with the mouse, and the Object Inspector will 
display those properties which may be set for the selected 
objects; font, color and size, for instance. 
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Figure 4.26 The Object Inspector showing 
edit field properties. 

Navigating the Object Inspector 
In the Object Inspector, each object property is listed on a 
separate line. To change a property value, click (or double-
click) the desired property name and enter the new value. 
Double-clicking some properties, such as Font and Color and 
MMFile (Multimedia File), will produce dialog boxes in which 
you must make selections or locate a filename; other 
properties, such as Macro and SelectList, produce a 
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dropdown list of available macros and selection lists from 
which you may choose. (See Figure 4.27). 

All objects of the current requester will appear from the 
dropdown list box, which is located just below the title bar. 
Scroll this list to select any object you wish to work with. 

Note that you may change the format of the Object Inspector 
by pointing the mouse to the separator line and dragging the 
mouse to either side. 

 
Figure 4.27: Use the Object Inspector 
to switch from one object to another. 
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The dropdown list box in the top of the Object Inspector 
contains all objects in the requester. Each object is represented 
by its object name as it appears in the ObjName property. If 
you wish to switch from one object to another, simply click the 
small arrow and select the object from the list. 

If the Object Inspector does not display, select Options, 
Inspector or press F11. If you wish the Object Inspector always 
to stay on top, click the right mouse button somewhere in the 
Object Inspector and select Stay on Top from the dropdown 
menu. If you wish to hide the Object Inspector, select Hide 
from the dropdown menu. 

Format Painter 
Format Painter is a useful formatting tool which enables you 
to copy the format of one object to another object, simply by 
clicking the objects with the mouse: 

Note that not all properties may be copied using the Format 
Painter. The object properties which can be copied will appear 
with a green text color in the Object Inspector. 

To use Format Painter: 

1. Click Select Object to enter selection mode. 

2. Click the object you wish to use as a basis of the format 
copy. 

3. If you wish to format the selected object at this point, 
use the Object Inspector. 

4. Click the Format Painter button. The mouse pointer 
transforms into a small brush, and the properties 
which may be copied turn green in the Object 
Inspector 
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5. Proceed to click the objects you wish to copy the 
format to. Each time you click an object, the format of 
the first object will be copied to the object that you 
click. 

6. To deactivate the Format Painter, click the Select 
Object tool. 

Figure 4.28: Formatting objects with the Format Painter. 
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Chapter 5: 
Screen Designer Objects 

he term object is a core term in Screen Designer. A 
requester screen consists of various types of objects that 

may all be manipulated in various ways by using Screen 
Designer. This chapter will introduce all objects in Screen 
Designer and explain in which ways they may be 
manipulated. 

The chapter is organized as follows: 

! Screen Designer Objects 

! Inserting an Object 

! Selecting an Object 

! Cutting, Copying and Pasting an Object 

! Formatting an Object 

! Deleting an Object 

! Restoring an Object 

! Moving an Object 

! Resizing an Object 

T
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Screen Designer Objects 

 
Figure 5.1: A requester screen with five buttons, a picture object, 
and several frames, text objects, and edit fields. 

As already mentioned, the term object is a core term in Screen 
Designer. Objects are divided into three types: 

• Tandem objects:   These objects are part of the original 
Scobol object code. Consequently, they are already on 
the screen when you load the requester. The objects 
include: Text fields (known as fillers in the Tandem 
vocabulary) and edit fields (known as fields). These 
objects may be formatted with Screen Designer 

• Screen Designer objects:  These objects are the objects 
which may be created and inserted with Screen 
Designer. These include: Text objects, push buttons, 
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pictures, frames, multimedia objects, and tabbed 
notebooks. 

• The requester object:   The requester object is the 
background on which all other objects are placed. Each 
requester has but one requester object. You cannot 
delete the requester object or create new requester 
objects with Screen Designer, but you may customize 
it on various levels. 

In this chapter we will present the various ways in which you 
may insert, remove, restore and format Screen Designer 
objects. 

As you load a requester into Screen Designer, each object will 
be assigned a unique object name. The syntax of this name is 
Objecttype(number), as in Text1, Text2, Edit1, Edit4, 
Button1, etc. Use the ObjName property in the Object 
Inspector to assign a more meaningful name to the object. 

Inserting an Object 
To insert a new object: 

1. From the Object menu, select the relevant command; 
Insert Text, Insert Button, Insert Picture, Insert 
Frame, Insert Multimedia, or Insert Tabbed 
Notebook Alternatively, click the corresponding 
button on the tool bar. 

2. If you use one of the commands from the Object 
menu, an object with a set of default properties will be 
inserted at the centre of the screen. 

3. If you insert the object by clicking one of the tool 
buttons on the tool bar, use the mouse to draw an 



S c r e e n  D e s i g n e r  

 106

object anywhere on the screen. If the object is drawn 
too small, it will automatically ‘snap’ to a certain 
minimum size. This feature is included to avoid you 
from creating small objects by unintentionally clicking 
the mouse. After the object has been created you may 
use the mouse to resize it - also to a size that is smaller 
than the initial minimum size. 

4. Use the Object Inspector to format the object. 

 
Figure 5.2: The Object menu. 

Selecting an Object 
Before you can work with an object on screen, you must select 
it. To select an object, first click Select Object in the tool bar to 
enter selection mode. Place the mouse cursor over the object and 
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click the left mouse button. Eight handles appear around the 
object, indicating that it is selected. 

 
Figure 5.3: The text object has been selected with the mouse and may be 
edited on various levels using the Object Inspector. 

Selecting Multiple Objects 
Screen Designer has two different selection modes for 
selecting multiple objects: enclose mode and touch mode. These 
modes are controlled from the Layout tab in the Preferences 
dialog box (see Figure 5.4). 

If the Enclose Objects check box is checked, the selection line 
indicating the selected area must be clear of the objects you 
wish to select. 

If the Touch Objects check box is checked, the selection line 
merely has to touch the objects you wish to select. 
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Figure 5.4: The current selection mode is controlled 
from the Layout tab of the Preferences dialog box. 

Screen Designer provides a variety of  ways to select multiple 
objects. For instance, to select a group of objects, first enter 
selection mode by clicking the Select Object tool, then drag 
the mouse over the objects in question (see Figure 5.5).  

Another way of selecting multiple objects is to press down the 
Shift-key and point the mouse to the objects you wish to select 
and click. To select a group of objects located in a frame, press 
down the Ctrl-key while dragging the mouse pointer over the 
objects. 
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Selecting multiple objects is useful, for instance, if you wish to 
move an entire group of objects to a different location or 
format multiple objects at the same time using the Object 
Inspector. 

 
Figure 5.2: Three buttons have been selected and may be formatted with the 
Object Inspector. Note that the current selection mode is enclose mode. 

Cutting, Copying and Pasting an Object 
To cut an object, select it and pick Cut from the Edit menu or 
click the Cut button on the tool bar. The object will be 
transferred to the Clipboard. Use Edit, Paste to insert the 
object. Alternatively, click the Paste button. 

You may also use the Cut command to cut several objects at a 
time. Select the objects before you use the command. 
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To copy an object, select it and pick Copy from the Edit menu 
or click the Copy button on the tool bar. The object will be 
transferred to the Clipboard. Use Edit, Paste to copy the 
object. Alternatively, click the Paste button. 

You may also use the Copy command to copy several objects 
at a time. Select the objects before you use the command. 

Formatting an Object 
Use the Object Inspector to format your objects in Screen 
Designer. The Object Inspector is a separate window that will 
display all properties of the object that is currently selected. 
Below you see the Object Inspector related to button objects.  

With the Object Inspector, you may adjust or set all properties 
of the object such as font, color, caption, object name, position, 
size and many more. It is also by means of the Object Inspector 
that you set up edit fields to use selection lists or hints and 
associate buttons with macros, function keys or multimedia 
clips. 
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Figure 5.6: The Object Inspector 
showing button properties. 
The Object Inspector enables you to format multiple objects at 
a time. Even objects of different types. Simply select the objects 
with the mouse and the Object Inspector will display those 
properties which may be set for the selected objects, font, 
color, and size, for instance. 

Also note the useful Format Painter tool, which enables you to 
copy the format of one object to another object, simply by 
clicking with the mouse. To use Format Painter: 

1. Click the Select Object tool to enter selection mode. 

2. Click the object(s) you wish to use as a basis of the 
format copy. 

3. If you wish to format the selected object at this point, 
use the Object Inspector. 
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4. Click the Format Painter button. The mouse pointer 
transforms into a small brush. 

5. Proceed to click the objects you wish to copy the 
format to. Each time you click an object, the format of 
the first object will be copied to the object that you 
click. 

The Object Inspector of each object type is thoroughly 
described in Chapter 6, Using Screen Designer. Read more 
about the Format Painter in Chapter 4. 

Deleting an Object 
To delete an object, select the object and press the Del-key or 
choose Delete from the Edit menu. The object will be removed 
from the main area. 

Note that the deletion will not be permanent until you save the 
requester and exit Screen Designer. As long as you are still 
working with the current requester, you may still access and 
restore objects which have previously been deleted. To access 
deleted objects, click the Restore Object button. For further 
details on this button, turn to the section Restoring an Object. 

Restoring an Object 
As mentioned in the previous section, you may still access and 
restore objects which have previously been deleted. 

To access deleted objects, select Edit, Restore Objects or click 
the Restore Object button on the tool bar. This will display the 
Restore Objects window. In this window, each deleted object 
is presented by its object name. To restore an object, place the 
cursor on the type indicator and click OK. 
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Figure 5.7: In the Restore Objects window, select the 
object(s) to restore and click the OK button. 
In connection with restoring deleted objects, you should take 
note of the following rules: 

• When you exit Screen Designer, all deleted objects -
apart from text objects - that were not originally part of 
the requester Scobol object code, will automatically be 
removed from the Restore Objects window. In other 
words, all objects which you have inserted with Screen 
Designer, and then removed again, will be removed 
from the Restore Objects window upon exit. 
Consequently, these objects will not be accessible the 
next time you load the requester into Screen Designer. 

• When you exit Screen Designer, information about 
deleted objects that were originally part of the 
requester Scobol object code will be stored. This means 
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that you may still access these objects from the Restore 
Objects window the next time you load the requester 
into Screen Designer. 

Moving an Object 
You can move any object to a different location in the main 
area. To move an object, select the object and place the mouse 
cursor over the object. Then drag the mouse. As you move the 
mouse, the outline frame of the object moves with it. Release 
the mouse button. 

When you are creating or formatting a tabbed notebook, we 
recommend that you move the tabbed notebook to the canvas 
area before moving and organizing the objects on the different 
tabs. In this way you have a clear view of both the objects on 
the requester screen and the tabbed notebook. 

Note that you may also change the position of an object from 
the Object Inspector. Simply enter new values in the Top and 
Left properties. This approach is useful when you wish to 
align several objects - horizontally or vertically. 

Resizing an Object 
You may want to change the size and shape of objects. You 
have various methods at your disposal: 

To scale an object with the mouse, select the object. Eight 
handles appear around the object, indicating that it is selected. 
Point to one of the four corner handles. The cursor transforms 
into a small two-headed arrow. Press the mouse button and 
drag the mouse until the object is the desired size. Release the 
mouse button. 
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To change the height of an object with the mouse, select the 
object and point to the top or bottom handle. The cursor 
transforms into a small two-headed arrow. Drag the mouse 
cursor until the object is the desired size. Then release the 
mouse button. 

To change the width of an object with the mouse, select the 
object and point to the left or right handle. The cursor 
transforms into a small two-headed arrow. Drag the mouse 
cursor until the object is the desired size. Then release the 
mouse button. 

You may also change the size of an object from the Object 
Inspector. Simply enter new values in the Width and Height 
entries. This approach is useful when you wish to give several 
objects the same size.  
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Chapter 6: 
Using Screen Designer 
This chapter is designed to illustrate the application of Screen 
Designer. By means of short, accurate examples we will 
explain the entire operation of Screen Designer. The chapter is 
organized as follows: 

! Starting Screen Designer 

! Opening and Saving a Requester 

! Working with the Requester Object 

! Working with Text Objects 

! Working with Buttons and Pictures 

! Working with Frames and Multimedia Clips 

! Working with Tabbed Notebooks 

! Working with Selection Lists and Edit Fields 

! Overlay Areas 

! When Requesters Have Been Updated on Tandem 
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Starting Screen Designer 
To run Screen Designer, double-click the Screen Designer icon 
in the Matterhorn group window. Screen Designer loads (see 
Figure 6.1). 

 
Figure 6.1: An empty Screen Designer application window. 

Opening and Saving a Requester 
To open or load a requester: 

1. From the File menu, select Open Requester or click 
the Open Requester button on the tool bar. Note that 
the four most recently loaded requesters will also 
appear from the File menu. 
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2. In the Open Requester dialog box, enter the requester 
name and, if relevant, the screen number. 

3. Click the OK button. 

4. The requester loads into the main work area. 

 
Figure 6.2: The Open Requester dialog box. Enter the 
requester name and screen number. 

If Screen Designer is unable to locate the requester, you will 
receive an error message. Please note that you may design a 
requester screen even as other users are running the requester. 
Also note that you may only work with one requester at a 
time. 

To save a requester: 

1. Select Save Requester from the File menu or click the 
Save Requester button. 

2. Information about the screen layout will be saved in a 
separate database. The next time you run the 
requester, Matterhorn will use this information to 
display the screen. 
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Working With the Requester Object 
The requester object is the background on which all other 
objects are placed. By assigning new properties to the 
requester object you may control whether or not the button 
panel is shown across the bottom of the screen, and customize 
the background color or add background effects such as 
wallpaper and/or gradients. You may also use the requester 
object to indicate that a multimedia file should be played 
while starting and/or  closing the requester. Finally, you may 
indicate a macro to be launched when the user performs an 
accept in the screen. 

 
Figure 6.3: The requester object is the background on which all other objects 
are placed. 

Each requester has got but one requester object. You cannot 
delete the requester object or create new requester objects with 
Screen Designer. 
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Formatting the Requester Object 
Use the Object Inspector to customize the requester object. To 
activate the Object Inspector, enter selection mode and click 
the background of the requester with the mouse. This will 
produce the Object Inspector depicted in Figure 6.4. The 
requester object properties will be described on the following 
pages. 

 
Figure 6.4: The Object Inspector 
showing properties of the requester 
object. 

ButtonPanelShow 
This property determines whether or not the button panel, 
which appears across the bottom of the screen during a 
Matterhorn session, will be displayed or not. Options are True 
and False. 

Note that this option may only be used when you are using 
Screen Designer together with MattWeb. 
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Color 
With the Color property you may change the background 
color of the requester. 

To change the background color, you may either click the 
Color property and select a standard Windows color from the 
dropdown list, or you may double-click the Color property to 
open the Color dialog box. Use this dialog box to select a 
background color. If you wish to fashion your own colors, 
click the Define Custom Colors button (see Figure 6.5). For 
more information about working with colors, turn to the 
Microsoft Windows User’s Guide. 

 
Figure 6.5: The Color dialog box. 

Note that you may indicate another color to be used as a 
gradient fill with the background color (see the Gradient 
property). 
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ColorUse 
This property determines whether or not the background 
color, indicated in the Color property will be shown. Options 
are True and False. 

Gradient 
Use this property to create a gradient fill. The color indicated 
by this property will fade to the color indicated in the Color 
property. If, for instance, you have chosen a gray background 
color and then select a blue gradient color, the screen will be 
filled with a shade of blue and gray. The shade style is 
determined by the entry in the GradientDirection property. 

Wallpapers and gradient fills do not exclude each other (see 
Figure 6.6) Thus, you may have a gradient fill display behind a 
wallpaper image. If, however, the wallpaper covers the entire 
screen, the gradient will not display. 

 
Figure 6.6: Use gradient fills and backgrounds to fashion your requesters. 
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GradientDirection 
This property determines the style of the gradient fill. Options 
are Top to Bottom and Left to Right. 

GradientUse 
This property determines whether the selected gradient fill 
will be used or not. Options are True and False. 

MMExit 
Use this property to indicate a multimedia clip to be played 
when the requester is terminated. What about a “See you 
tomorrow”-greeting from the department head? Click the 
small button to the right of the property name and locate the 
multimedia clip in the Open Multimedia Clip dialog box. 

MMExitUse 
This property determines whether or not the multimedia clip 
indicated by the MMExit property will be played when the 
user terminates the requester. Options are True and False. 

MMIntro 
Use this property to indicate a multimedia clip that will be 
played when the requester is launched. What about a 
“Welcome to work”-greeting from the department head? Click 
the small button to the right of the property name and locate 
the multimedia clip in the Open Multimedia Clip dialog box. 
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MMIntroUse 
This property determines whether or not the multimedia clip 
indicated by the MMIntro property will be used when the 
user launches the requester. Options are True and False. 

OnAccept 
Use this property to indicate a macro that is to be launched as 
the user performs an accept of the screen, for instance when 
exiting or updating the requester or moving on to another 
requester. This option may used as a time saving feature in 
many cases. For instance, you may write a macro that inserts 
default values in specific fields of the following requester as 
the user proceeds to this requester. 

Click the small button to the right of the property name and 
locate the macro on the list. 

WallpaperBitmap 
Use this property to indicate a wallpaper for the screen. 
Wallpapers and gradient fills do not exclude each other. Thus, 
you may have a gradient fill display behind a wallpaper 
image. If, however, the wallpaper covers the entire screen, the 
gradient will not display. 

Click the button to the right of the property name to open the 
Open Picture dialog box. Locate the image and click OK. 

WallpaperPos 
Use this property to indicate the position of the wallpaper. 
Options are Centered, Stretched, and Tiled. 



S c r e e n  D e s i g n e r  

 125

WallpaperUse 
This property determines whether or not the wallpaper 
indicated by the WallpaperBitmap property will be used. 
Options are True and False. 

Note that you may temporarily deactivate the wallpaper by 
unchecking the Show Wallpaper check box in the Layout tab 
in the Preferences dialog box. This will reduce the strain on 
Screen Designer, since screen updates will be processed much 
faster. 

Working with Text Objects 
In Screen Designer, text objects are either existing text fields 
(known as fillers in the Tandem world) or text objects, which 
are created with Screen Designer. You may create new text 
objects to complement the perception of the screen, for 
instance, by entering titles, subtitles, logos or guiding captions. 

Inserting Text Objects 
To insert a text object 

1. From the Object menu, select Insert Text, or click the 
Insert Text button on the tool bar. 

2. If you insert the object with the Insert Text command 
from the Object menu, a text object with a set of 
default properties will be inserted at the centre of the 
screen. 

3. If you insert the text object using the Insert Text 
button on the tool bar, simply click on the requester 
background to insert a text object with a default size. If 
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you wish the object to have a certain size, use the 
mouse to draw the text object. 

4. Use the Object Inspector to format the object. For more 
information, turn to the section Formatting Text 
Objects. 

Formatting Text Objects 
Use the Object Inspector to format your text objects. To 
activate the Object Inspector, enter selection mode and select 
the text object with the mouse. This will produce the Object 
Inspector depicted in the figure below. The text properties will 
be described on the following pages. 

 
Figure 6.7: The Object Inspector 
showing text properties. 
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Caption 
If you wish to change the text in the text object, select Caption 
from the Object Inspector. Enter the new text. Note that you 
may use the &-character to indicate that the following letter 
will be used as a hot key. 

Font 
If you wish to use a new font or perhaps adjust the size of the 
current font, select Font in the Object Inspector. Click the 
button to the left of the Font property to open the Font dialog 
box depicted below. 

 
Figure 6.8: The Fonts dialog box. 



S c r e e n  D e s i g n e r  

 128

From the dialog box you may select a new TrueType font, 
change the font style and the font size. Also, you may assign 
display effects such as strikeout and underline. Finally, you 
may choose between different colors for the text. 

Note that there is an upper limit as to the size of the font. If the 
text becomes too large to fit in the screen, it will be truncated. 

FontColorUse 
This property determines whether or not the font color 
indicated with the Font property will be used for the text 
object letters during execution of the requester. Options are 
True and False. If you set the option to False, the requester will 
use the font color defined in the Preferences dialog box in the 
Matterhorn Client. 

FontUse 
This property determines whether or not the font face 
indicated with the Font property will be used during 
execution of the requester. Options are True and False. If you 
set the option to False, the requester will use the font defined in 
the Preferences dialog box in the Matterhorn Client. 

Color 
With the Color property you may change the background 
color of your text object. To change a background color, you 
may either click the Color property and select a standard 
Windows color from the dropdown list, or you may double-
click the Color property to open the Color dialog box. Use this 
dialog box to select a background color. If you wish to fashion 
your own colors, click the Define Custom Colors button (see 
Figure 6.9). For more information about working with colors, 
turn to the Microsoft Windows User’s Guide. 
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ColorUse 
This property determines whether or not the color indicated 
with the Color property will be used as background color for 
the text object. Options are True and False. If you set the option 
to False, the requester will use the font defined in the 
Preferences dialog box in the Matterhorn Client. 

 
Figure 6.9: The Color dialog box. 

ObjName 
This property will display the unique name of the object. Feel 
free to pick any name. The maximum length of an object name 
is 20 characters. 
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Width 
Use this option to change the width of the text object. The unit 
of measurement is pixels. If you use the mouse to change the 
width, the Width property will change accordingly. 

Top 
Use this option to change the Y-coordinate of the upper left 
corner of the text object. If you use the mouse to drag the text 
object to a new position, the Top property will change 
accordingly. 

If the object is located on a tabbed notebook, the Top property 
will reflect the Y-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

Left 
Use this option to change the X-coordinate of the upper left 
corner of the text object. If you use the mouse to drag the text 
object to a new position, the Left property will change 
accordingly. 

If the object is located on a tabbed notebook, the Left property 
will reflect the X-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

Height 
Use this option to change the height of the text object. The unit 
of measurement is pixels. If you use the mouse to change the 
height, the Height property will change accordingly. 
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Transparent 
If text objects are to overlap each other, you may wish to make 
the background of the object which is placed in front of other 
objects transparent. In this way, objects in back of it show 
through. Set the Transparent property to True to make the text 
object transparent. 

Note that the ColorUse property changes to False when the 
Transparent property is set to True. 

URL 
Screen Designer enables you to activate URLs (http, ftp, 
mailto, news, etc.) from within your requesters. You can use 
this feature to establish a connection to a server on the Internet 
or when you are creating your own company intranet. When 
the user clicks the text object associated with an URL, the URL 
will be located. 

Note that this feature may only be used with MattWeb. 

URLUse 
This property will determine whether or not the URL that you 
have entered in the URL property will be called when the user 
clicks the text object. Options are True and False. 

Note that this feature may only be used with MattWeb. 

Working with Buttons 
In Screen Designer you may associate push buttons with 
function keys,  macros and multimedia clips. For instance, if a 
text prompts the user to press F5 in order to access the order 
file, you may use Screen Designer to create a push button 
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entitled Order File and then associate this button with the F5 
function key. The user then simply has to click the Order File 
button to access the order file. Likewise, a macro that merges 
address information with a standard letter may be launched 
by clicking a Screen Designer button labeled Merge Letter. 

Inserting Buttons 
To insert a new button: 

1. From the Object menu, select Insert Button, or click 
Insert Button on the tool bar. 

2. If you insert the button with the Insert Button 
command from the Object menu, a button object with 
a set of default properties will be inserted at the centre 
of the screen. 

3. If you insert the button by clicking Insert Button on 
the tool bar, use the mouse to draw a button anywhere 
on the screen. 

4. Use the Object Inspector to format the button. For 
further information, turn to the section Formatting 
Buttons. 

5. Finally, use the mouse to drag the button to another 
location. 

Formatting Buttons 
Use the Object Inspector to format your buttons. To activate 
the Object Inspector, select the button with the mouse. This 
will produce the Object Inspector depicted in the figure next 
page. The options will be described on the following pages. 
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ObjName 
This property will display the unique name of the object. Feel 
free to pick any name. The maximum length of an object name 
is 20 characters. 

Click 
To assign a function key to an existing button, select the Click 
property from the Object Inspector. In the dropdown list box, 
select the key to assign. 

 
Figure 6.10: The Object Inspector 
displaying button properties. 
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ActKey 
Use this property to associate a shortcut key or keyboard 
combination such as ALT+C with the button. ActKey enables 
you to activate the button using the keyboard. Click the 
property and enter the keyboard combination in the 
Activation Key dialog box. 

Caption 
If you wish to change the button title, select Caption from the 
Object Inspector. Enter the new title and press Enter. 

 
Figure 6.11: Select an activation key for the button. 

Font 
If you wish to use a new font or perhaps adjust the existing 
font, select Font in the Object Inspector. This will produce the 
Font dialog box. 

From the dialog box you may select a new TrueType font, 
change the font style and the font size. Also, you may assign 
display effects such as strikeout and underline. 
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Figure 6.12 The Font dialog box. 

FontUse 
This property determines whether or not the font face 
indicated with the Font property will be used for the button 
during execution of the requester. Options are True and False. 
If you set the option to False, the button will use the font 
defined in the Preferences dialog box in the Matterhorn 
Client. 
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Width 
Use this option to change the width of the button. The unit of 
measurement is pixels. If you use the mouse to change the 
width, the Width property will change accordingly 

 

Top 
Use this option to change the Y-coordinate of the upper left 
corner of the button. If you use the mouse to drag the button to 
a new position, the Top property will change accordingly. If 
the object is located on a tabbed notebook, the Top property 
will reflect the Y-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

Left 
Use this option to change the X-coordinate of the upper left 
corner of the button. If you use the mouse to drag the button to 
a new position, the Left property will change accordingly. 

If the object is located on a tabbed notebook, the Left property 
will reflect the X-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

Height 
Use this option to change the height of the button. The unit of 
measurement is pixels. If you use the mouse to change the 
height, the Height property will change accordingly. 
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Macro 
Use this option to associate a macro with the button. To choose 
a macro, click the small button to the right of the property 
name. Locate the macro on the list. Only macros created with 
the Matterhorn macro language will appear from the list. The 
chosen macro will be launched when the user clicks the 
button. 

MMFile 
Use this option to associate the button with a multimedia file. 
The option will open the Open Multimedia Clip dialog box. 
In this dialog box, select the file type and locate the 
multimedia file to associate with the button. Note that you 
may make entries for both MMFile and MMObject. Which of 
the two options are used is determined by your selection for 
the MMSelect property. 

MMObject 
Use this option to associate the button with a multimedia 
object. The option displays a list of available multimedia 
objects for this requester. More precisely, the names on the list 
are the names that you have entered in the ObjName property 
when you created your multimedia objects. Note that you may 
make entries for both MMFile and MMObject. Which of the 
two options are used is determined by your selection for the 
field MMSelect. 

MMSelect 
Use this option to indicate which of the two options MMFile 
and MMObject will be used when the user clicks the button 
during a Matterhorn session. Options are: 
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None None of the multimedia clips will be 
available to the user. 

File The multimedia file will be played when 
the user clicks the button. 

Object The multimedia object will be played 
when the user clicks the button. 

Hint 
With this option you may associate a hint with the button 
object. A hint is a piece of guiding text that will be displayed 
when the user points the mouse cursor to the button. The hint 
will only be displayed if the HintShow property has been set 
to True (see below). The maximum length of a hint is 40 
characters. 

HintShow 
This property will determine whether or not the hint that you 
have entered in Hint will be displayed. Options are True and 
False. 

URL 
Screen Designer enables you to activate URLs (http, ftp, 
mailto, news, etc.) from within your requesters. You can use 
this feature to establish a connection to a server on the Internet 
or when you are creating your own company intranet. When 
the user clicks the text object associated with an URL, the URL 
will be located. 

Note that this feature may only be used with MattWeb. 
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URLUse 
This property will determine whether or not the URL that you 
have entered in the URL property will be called, when the 
user clicks the button. Options are True and False. 

Note that this feature may only be used with MattWeb. 

Working with Pictures 
Screen Designer allows you to insert graphic images into your 
requester screens. For instance, you may insert your own 
images to support the general perception of the screen. You 
may use company logos or images depicting your company 
products etc. Also, you may associate a picture with a 
multimedia clip or a macro that will be executed as the user 
clicks the picture. 

Inserting Pictures 
To insert a picture: 

1. From the Object menu, select Insert Picture, or click 
the Insert Picture button on the tool bar. 

2. If you insert the picture with the Insert Picture 
command from the Object menu, a picture object with  
set of default properties will be inserted at the centre 
of the screen. 

3. If you insert the picture by clicking the Insert Picture 
button, use the mouse to draw a picture object 
anywhere on the screen. 
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Figure 6.13: In the Open Picture dialog box, locate the 
picture you wish to insert. 

4. Use the Object Inspector to format the picture. For 
further information, turn to the section Formatting 
Pictures. 

5. Finally, use the mouse to drag the picture to another 
location. 

Formatting Pictures 
Use the Object Inspector to format your pictures. To activate 
the Object Inspector, select the picture object with the mouse. 
This will open the Object Inspector depicted in Figure 6.14 
next page. The options will be described on the following 
pages. 

Filename 
The Filename property will display the filename of the current 
picture. To associate the object with a picture, click the small 
button to the right of the filename. This will open the Open 
Picture dialog box. Locate the image and click OK to load it 
into Screen Designer. 
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Click  
Use the Click property to assign a function key to the picture. 
To assign a function key to an existing picture, select the Click 
property from the Object Inspector. In the dropdown list box, 
select the key to assign. When the user clicks the picture, the 
command associated with this function key will be executed. 

 

 

 

Width 
Use the Width property to change the width of the picture. 
The unit of measurement is pixels. If you use the mouse, the 
Width property will change accordingly. 
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Figure 6.14: The Object Inspector showing 
picture properties. 

Top 
Use the Top property to change the Y-coordinate of the upper 
left corner of the picture object. If you use the mouse to drag 
the picture, the value will change accordingly. If the object is 
located on a tabbed notebook, the Top property will reflect the 
Y-coordinate of the object’s upper-right corner relative to the 
tabbed notebook, not to the requester object. 
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OnDisk 
Use the OnDisk property to indicate whether the picture file is 
located on disk or in the Screen Designer database. Options 
are True (on disk) or False (in Screen Designer database). 

ObjName 
This property will display the unique name of the picture. Feel 
free to pick any name. The maximum length of an object name 
is 20 characters. 

Macro 
Use this option to associate a macro with the picture. To 
choose a macro, click the small button to the right of the 
property name. Locate the macro on the list. Only macros 
created with the Matterhorn macro language will appear from 
the list. The chosen macro will be launched when the user 
clicks the picture. 

Left 
Use the Left property to change the X-coordinate of the upper 
left corner of the picture. If you use the mouse to drag the 
picture, the Left property will change accordingly. If the object 
is located on a tabbed notebook, the Left property will reflect 
the X-coordinate of the object’s upper-right corner relative to 
the tabbed notebook, not to the requester object. 

Height 
Use the Height property to change the height of the picture 
object. The unit of measurement is pixels. If you use the mouse 
to change the height, the value will change accordingly. 
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MMFile 
Use this option to associate the picture with a multimedia file. 
The option will open the Open Multimedia Clip dialog box. 
In this dialog box, select the file type and locate the 
multimedia file to associate with the picture. Note that you 
may make entries for both MMFile and MMObject. Which of 
the two options is used depends on your selection for the 
MMSelect property. 

MMObject 
Use this option to associate the picture with a multimedia 
object. The option displays a list of available multimedia 
objects for this requester. To be more specific, the names on the 
list are the names that you have entered in the ObjName 
property when you created your multimedia objects. Note that 
you may make entries for both MMFile and MMObject. Which 
of the two options is used depends on your selection for the 
field MMSelect. 

MMSelect 
Use this option to indicate which of the two options MMFile 
and MMObject will be used when the user clicks the picture 
during a Matterhorn session. Options are: 

None None of the multimedia clips will be 
available to the user. 

File The multimedia file will be played when 
the user clicks the picture. 

Object The multimedia object will be played 
when the user clicks the picture. 
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Hint 
With this option you may associate a hint with the picture 
object. A hint is a piece of guiding text that will be displayed 
when the user points the mouse cursor to the picture. The 
maximum length of a hint is 40 characters. The hint will only 
be displayed if the HintShow property has been set to True. 

HintShow 
This property will determine whether or not the hint that you 
have entered in Hint will be displayed. Options are True and 
False. 

URL 
Screen Designer enables you to activate URLs (http, ftp, 
mailto, news, etc.) from within your requesters. You can use 
this feature to establish a connection to a server on the Internet 
or when you are creating your own company intranet. When 
the user clicks the text object associated with an URL, the URL 
will be located. 

Note that this feature may only be used with MattWeb. 

URLUse 
This property will determine whether or not the URL that you 
have entered in the URL property will be called, when the 
user clicks the picture. Options are True and False. 

Note that this feature may only be used with MattWeb. 
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Working with Frames 
In order to make a requester screen more clear, you may insert 
a frame around fields that have similar meanings or purposes. 
In addition, you may assign various display effects to your 
frames. 

Inserting Frames 
To insert a frame: 

1. From the Object menu, select Insert Frame, or click 
the Insert Frame button on the tool bar. 

2. If you insert the frame with the Insert Frame 
command from the Object menu, a frame with a set of 
default properties will be inserted at the centre of the 
screen. 

3. If you insert the frame by clicking Insert Frame on the 
tool bar, use the mouse to draw the frame object 
anywhere on the screen. 

4. Use the Object Inspector to format the frame. For 
further information, turn to the section Formatting 
Pictures. 

5. Finally, use the mouse to drag the frame to another 
location. 

Formatting Frames 
Use the Object Inspector to format your frames. To activate the 
Object Inspector, select the frame with the mouse. This will 
produce the Object Inspector. The frame properties will be 
described on the following pages. 
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Figure 6.15: The Object Inspector showing 
frame properties. 

FrameStyle 
Use the FrameStyle property to change the style of the frame. 
Options are; Normal, Raised, Lowered, 3DRaised and 3DLowered. 

Normal If you select this option, the frame will be 
drawn with simple borders. 

Raised 

 

If you select this option, the frame will be 
drawn with simple borders. It will appear 
raised, compared to other objects on the 
screen. 

Lowered If you select this option, the frame will be 
drawn with simple borders. It will appear 
countersinked, compared to other objects 
on the screen. 

3DRaised If you select this option the frame will be 
drawn with three-dimensional borders. It 
will appear raised, compared to other 
objects on the screen. 
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3Dlowered If you select this option the frame will be 
drawn with three-dimensional borders. It 
will appear countersinked, compared to 
other objects on the screen. 

Width 
Use the Width property to change the width of the frame. The 
unit of measurement is pixels. If you use the mouse to change 
the width, the Width property will change accordingly. 

Top 
Use the Top property to change the Y-coordinate of the upper 
left corner of the frame. If you use the mouse to drag the 
frame, the value will change accordingly. If the object is 
located on a tabbed notebook, the Top property will reflect the 
Y-coordinate of the object’s upper-right corner relative to the 
tabbed notebook, not to the requester object. 

Left 
Use the Left property to change the X-coordinate of the upper 
left corner of the frame. If you use the mouse to drag the 
picture, the Left property will change accordingly. If the object 
is located on a tabbed notebook, the Left property will reflect 
the X-coordinate of the object’s upper-right corner relative to 
the tabbed notebook, not to the requester object. 

ObjName 
This property will display the unique name of the frame. Feel 
free to pick any name. The maximum length of an object name 
is 20 characters. 
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Height 
Use the Height property to change the height of the frame 
object. The unit of measurement is pixels. If you use the mouse 
to change the height of the frame, the value will change 
accordingly. 

Working with Multimedia Clips 
You may use Screen Designer to insert multimedia clips in 
your Tandem requesters. A multimedia clip may be associated 
with a bitmap or a button and the user subsequently plays the 
multimedia clip by clicking the button or bitmap. Screen 
Designer supports all MCI (Media Control Interface) 
extensions supported by your Windows version. 

A video clip may either be executed within the Matterhorn 
session window or in a separate window. 

Multimedia Objects and Multimedia Files 
In Screen Designer you will meet the two terms multimedia 
objects and multimedia files. It is easy to distinguish between the 
two types: 

• A multimedia file is a native MCI-compatible file 
located somewhere on your system. 

• A multimedia object is a Screen Designer object, 
created, stored and formatted from within Screen 
Designer. The object points to a multimedia file, but 
Screen Designer also allows you to attach various 
display properties to the file. 

In this book, when we refer to both multimedia files and 
multimedia objects with one phrase, we use the word 
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multimedia clips. Otherwise the two words refer to different 
entities. 

 
Figure 6.16: Use Screen Designer to insert multimedia clips in your 
Tandem requesters. 

Creating Multimedia Objects 
1. From the Object menu, select Insert Multimedia, or 

click the Insert Multimedia button on the tool bar. 

2. If you insert the multimedia object with the Insert 
Multimedia command from the Object menu, a 
multimedia object with a set of default properties will 
be inserted at the centre of the screen. 

3. If you insert the multimedia object by clicking Insert 
Multimedia on the tool bar, use the mouse to draw the 
multimedia object anywhere on the screen. 
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4. Use the Object Inspector to format the object. For 
further information, turn to the section Formatting 
Multimedia Objects. 

5. Finally, use the mouse to drag the object to another 
location. 

Figure 6.17: Locate the multimedia file in the Open Multimedia 
Clip dialog box. 

Formatting Multimedia Objects 
Use the Object Inspector to format your multimedia objects. To 
activate the Object Inspector, select the multimedia object with 
the mouse. This will open the Object Inspector. 
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Figure 6.18: The Object Inspector showing 
multimedia object properties. 

FrameStyle 
Use the FrameStyle property to change the style of the frame 
surrounding the multimedia object. Options are; Panel, Raised, 
Lowered, 3DRaised and 3DLowered. 

Panel If you select this option, the frame will be 
drawn with a simple line. It will appear 
countersinked, compared to other objects 
on the screen. 

Raised If you select this option, the frame will be 
drawn with simple two-dimensional 
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 borders. It will appear raised, compared 
to other objects on the screen. 

Lowered If you select this option, the frame will be 
drawn with simple two-dimensional 
borders. It will appear countersinked, 
compared to other objects on the screen. 

3DRaised If you select this option the frame will be 
drawn with three-dimensional borders. It 
will appear raised, compared to other 
objects on the screen. 

3DLowered If you select this option the frame will be 
drawn with three-dimensional borders. It 
will appear countersinked, compared to 
other objects on the screen. 

Width 
Use the Width property to change the width of the multimedia 
object. The unit of measurement is pixels. If you use the mouse 
to change the width, the Width property will change 
accordingly. 

Top 
Use the Top property to change the Y-coordinate of the upper 
left corner of the multimedia object. If you use the mouse to 
drag the multimedia object, the value will change accordingly. 
If the object is located on a tabbed notebook, the Top property 
will reflect the Y-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 
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Left 
Use the Left property to change the X-coordinate of the upper 
left corner of the multimedia object. If you use the mouse to 
drag the picture, the Left property will change accordingly. If 
the object is located on a tabbed notebook, the Left property 
will reflect the X-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

ObjName 
This property will display the unique name of the multimedia 
object. You may enter a name of your own choice. Use this 
name to link the multimedia object to a button or a picture. 
The maximum length of an object name is 20 characters. See 
the section Associating a Multimedia Clip with a Button. 

Height 
Use the Height property to change the height of the 
multimedia object. The unit of measurement is pixels. If you 
use the mouse to change the height of the multimedia object, 
the value will change accordingly. 

Hint 
With this option you may associate a hint with the multimedia 
object. A hint is a piece of guiding text that will be displayed 
when the user points the mouse cursor to the object. The 
maximum length of a hint is 40 characters. The hint will only 
be displayed if the HintShow property has been set to True. 
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HintShow 
This property will determine whether or not the hint that you 
have entered in Hint will be displayed. Options are True and 
False. 

MMFile 
Use this property to open the Open Multimedia Clip dialog 
box. In the Open Multimedia Clip dialog box, select the file 
type and locate the desired multimedia file. 

OnLoad 
Use this option to determine at what time the multimedia clip 
will be played. Options are No Action, Auto Play and Auto Play 
Once. If you select Auto Play, the multimedia clip will loop 
upon startup for as long as the user is running the requester. 
Auto Play Once will play the clip just once during startup. If 
you select No Action, the multimedia object will be represented 
by a blank frame. When the user double-clicks the frame, the 
multimedia object will be played once. 

Click 
To associate a function key with the multimedia object, select 
the Click property from the Object Inspector. In the dropdown 
list box, select the key to assign. When the user clicks the 
object, the command will be performed. Note that the user 
must double-click the multimedia object to play it. 

Stretch 
Options for the Stretch property are True and False. True will 
stretch the multimedia clip (video - not sound!) to fill out the 
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entire object frame. False will display  the clip in its original 
size. 

URL 
Screen Designer enables you to activate URLs (http, ftp, 
mailto, news, etc.) from within your requesters. You can use 
this feature to establish a connection to a server on the Internet 
or when you are creating your own company intranet. When 
the user clicks the text object associated with an URL, the URL 
will be located. 

Note that this feature may only be used with MattWeb. 

URLUse 
This property will determine whether or not the URL that you 
have entered in the URL property will be called, when the 
user play the multimedia clip. Options are True and False. 

Note that this feature may only be used with MattWeb. 

Macro 
Use this option to associate a macro with the multimedia clip. 
To choose a macro, click the small button to the right of the 
property name. Locate the macro on the list. Only macros 
created with the Matterhorn macro language will appear from 
the list. The chosen macro will be launched when the user 
clicks the multimedia object. 

Note that the user must double-click the multimedia object in 
order to actually play it. 
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Associating a Multimedia Clip with a Button 
To associate a multimedia clip with a button: 

1. Enter selection mode and select the desired button 
with the mouse. The Object Inspector of that object will 
display. 

2. In the Object Inspector, three properties are relevant to 
running the multimedia clip: MMFile, MMObject and 
MMSelect. The first two properties determine 
whether the multimedia clip is a multimedia file or a 
multimedia object. When executed, a multimedia file 
will be displayed in a separate window in Windows, 
whereas the multimedia object will run inside the 
Matterhorn session window. The last property, 
MMSelect, tells Matterhorn which of the two first 
properties to use: MMFile or MMObject. 

3. If you wish to run a multimedia file in a separate 
window, click the MMFile property to open the Open 
Multimedia Clip dialog box. In this dialog box, select 
the desired MCI file type and locate the multimedia 
file you wish to use. 

4. If you wish to run a multimedia object, click the 
MMObject property. This will display a list of 
available multimedia objects in Screen Designer. More 
precisely, the names on the list are the names that you 
have entered in the ObjName property when you 
created your multimedia objects. (See the section 
Creating a Multimedia Object). 

5. Note that you may make entries for both MMFile and 
MMObject. Which of the two options are used, will be 
determined by your selection for the field MMSelect. 

 



S c r e e n  D e s i g n e r  

 158

None None of the multimedia clips will be 
available to the user. 

File The multimedia file will be played when 
the user clicks the button. 

Object The multimedia object will be played 
when the user clicks the button. 

Associating a Multimedia Clip with a Picture 
To associate a multimedia clip with a picture in Screen 
Designer, follow the procedure described in the previous 
pages. The two processes are identical. Simply make your 
entries in the MMFile, MMObject and MMSelect properties 
in the Object Inspector. 

Working with Tabbed Notebooks 
Tabbed notebooks enable you to organize the objects of a 
requester on separate tabs, just like most users know them 
from their Windows applications. Not only do tabbed 
notebooks help you organize the objects of your requesters 
better. They also provide more space on the screen. By 
grouping the fields of a requester on tabs with meaningful 
titles, screens will appear less confusing to users. The 
administrator who is in charge of designing screens will find it 
easy and fulfilling to work with tabbed notebooks. 
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Figure 6.19: Screen Designer enables you to create tabbed notebooks to 
organize your screens better. 

Creating a Tabbed Notebook 
To create a tabbed notebook: 

1. Select Insert Tabbed Notebook from the Object menu 
or click the Insert Tabbed Notebook button on the 
tool bar. 

2. A blank tabbed notebook is inserted in the centre of 
the main work area. If you wish to move the tabbed 
notebook to another location, point to its background 
(not to the tab caption) and drag it with the mouse. 
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Figure 6.20: In Screen Designer the tabbed notebook object is 
inserted in the centre of the application window. 

3. By default, the object contains two tabs. It is not 
possible to create a tabbed notebook with less than two 
tabs. On the other hand, try not to create too many tabs 
as this will ruin the purpose of the tabbed notebook: to 
provide clarity. 

4. The Object Inspector will display a set of default 
properties related to the tabbed notebook. 

5. Use the Object Inspector to indicate the number of tabs 
in this tabbed notebook and give them meaningful 
captions (see the section Creating, Naming and 
Deleting Tabs later in this chapter). 

6. Move the objects from the requester object to the 
tabbed notebook and arrange them on the relevant 
tabs. You move from one tab to another by clicking the 
tab caption, just as you would in “real life”. See the 
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following section Moving Objects to a Tabbed 
Notebook . 

Moving Objects to a Tabbed Notebook 
Before you  start moving objects to the tabbed notebooks, we 
recommend that you enlarge the Screen Designer application 
window to display the canvas area. Then move the tabbed 
notebook to the canvas area. In this way you have a clear view 
of both the objects on the requester screen and the tabbed 
notebook (see Figure 6.21). 

 

Figure 6.21: Enlarge the Screen Designer application window to 
display the canvas area. 

All types of existing objects in the requester may be moved to 
the tabs of the notebook, including other tabbed notebooks. To 
move an existing object to a tab, simply select the object with 
the mouse and drag it to the tab. Then release the mouse 
button to drop the object. Of course, you may also move 
several objects at a time. For more information on selecting 
objects, turn to the section Selecting Multiple Objects in 
Chapter 5, Screen Designer Objects. 



S c r e e n  D e s i g n e r  

 162

Likewise, all types of objects in Screen Designer (apart from 
the requester object) may be created and inserted on a tabbed 
notebook. You can also create new tabbed notebooks on 
existing ones. 

As you drag objects over the tabbed notebook, a square line 
surrounding the tabbed notebook will highlight, indicating 
that the objects are over the tabbed notebook. If the objects are 
outside the highlighted area, and you drop the objects, they 
will not be inserted on the tabbed notebook, but “fall” through 
to the object(s) in the background. Note that you cannot drop 
objects on the tab captions. They must be inserted on the 
actual body of the tabbed notebook. 

 
Figure 6.22: An entire group of objects has been moved to the tabbed 
notebook in one go. 

Also note that the Top and Left properties of the moved 
objects will change, reflecting the objects’ positions relative to 
the tabbed notebook, not to the requester object. 
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Creating, Naming or Deleting Tabs 
To create, name, or delete tabs and tab captions: 

1. Select the tabbed notebook with the mouse. 

2. Click the Tabs property to open the Tab Editor dialog 
box. 
 

 
Figure 6.23: The Tabs Editor dialog box. 

3. Click + to create a new tab and enter a relevant tab 
caption. 
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4. Highlight an existing tab, and click ab| to rename it, or 

- to delete it. As mentioned, a tabbed notebook must 
contains at least two tabs. 

5. If you wish to change the order of the tabs on the 
tabbed notebook, click # or $. 

6. Click OK to return to the Object Inspector. 

Formatting Tabbed Notebooks 
Use the Object Inspector to format your tabbed notebooks. To 
activate the Object Inspector, select the tabbed notebook with 
the mouse. This will open the Object Inspector depicted below. 

 
Figure 6.24: The Object Inspector 
showing tabbed notebook properties. 

Font 
If you wish to use a new font for the tab caption or perhaps 
adjust the size of the current font, select Font in the Object 
Inspector. Click the button to the left of the Font property to 
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open the Font dialog box. From the dialog box you may select 
a new TrueType font, change the font style and the font size. 
Also, you may assign display effects such as strikeout and 
underline. 

FontUse 
This property determines whether or not the font face 
indicated with the Font property will be used for the tab 
caption. Options are True and False. If you set the option to 
False, the caption will be shown with the font indicated in the 
Preferences dialog box in the Matterhorn Client. 

Height 
Use this option to change the height of the tabbed notebook. 
The unit of measurement is pixels. If you use the mouse to 
change the height, the Height property will change 
accordingly. 

Hint 
With this option you may associate a hint with the tabbed 
notebook. A hint is a piece of guiding text that will be 
displayed when the user points the mouse cursor to the tabbed 
notebook. The maximum length of a hint is 40 characters. The 
hint will only be displayed if the HintShow property has been 
set to True (see below). 

HintShow 
This property will determine whether or not the hint that you 
have entered in Hint will be displayed. Options are True and 
False. 
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Left 
Use this option to change the X-coordinate of the upper left 
corner of the tabbed notebook. If you use the mouse to drag 
the tabbed notebook to a new position, the Left property will 
change accordingly. 

ObjName 
This property displays the unique name of the tabbed 
notebook. Feel free to pick any name. The maximum length of 
an object name is 20 characters. 

Tabs 
Use this property to specify a tab caption or add new tabs to 
the tabbed notebook. Click the property to open the Tab 
Editor dialog box. From this dialog box you may also add and 
delete tabs and change the order of the tabs. As mentioned, a 
tabbed notebook cannot consist of less than two tabs. 

Top 
Use this option to change the Y-coordinate of the upper left 
corner of the tabbed notebook. If you use the mouse to drag 
the notebook to a new position, the Top property will change 
accordingly. 

Width 
Use this option to change the width of the tabbed notebook. 
The unit of measurement is pixels. If you use the mouse to 
change the width, the Width property will change 
accordingly. 
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Restoring Objects from a Tabbed Notebook 
If you have deleted an object from a tabbed notebook and wish 
to restore it, the object will be inserted on the requester object, 
not on the tabbed notebook. Subsequently, you have to drag 
and drop the object back onto the tabbed notebook. 

Restoring a Tabbed Notebook 
If you have deleted a tabbed notebook, you cannot restore it 
with the Restore Objects command. Instead you may use the 
Undo button to restore the notebook. 

16- and 32-Bit Tabbed Notebooks 
The appearance of tabbed notebooks varies slightly depending 
on whether you are working with a 16- or 32-bit version of 
Screen Designer. 

In 32-bit Screen Designer, a tiny invisible line along the edge of 
the tabbed notebook forms a potential trap, when you are 
moving objects to the tabbed notebook. If you by accident 
drop the objects over this line - it is only 4 pixels wide - the 
objects will fall through the tabbed notebook. You then have to 
move the objects once again, this time making sure that you do 
not hit the invisible line. 

In a 16-bit tabbed notebook with many tabs you will not be 
able to scroll between the tabs. Instead the tab captions will be 
arranged to fit the size of the tabbed notebook. 



S c r e e n  D e s i g n e r  

 168

 
Figure 6.25: A 16-bit tabbed notebook. 
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Figure 6.26: A 32-bit tabbed notebook. 

Working with Selection Lists 
With Screen Designer you may create or import selection lists 
and subsequently associate them with specific edit fields. A 
selection list is a fixed number of valid entries which may be 
used for a specific field. For instance, you may associate all 
valid zipcodes with a Zipcode field or all valid currency codes 
with a Currency Code field. When users click these fields, the 
values will be displayed in a dropdown list box. 

Note that you may also use Screen Designer to maintain or 
update selection lists that have previously been created. 

Associating a selection list with an edit field will ensure that 
users always select between valid values, preventing 
misspellings and other types of user input errors. 
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Figure 6.27: In the Selection Lists dialog box you may either pick existing 
selection lists for editing or create new selection lists. 

Sources of a Selection List 
The values in a selection list may come from one of four 
different sources: Your first option is to enter the values for a 
selection list manually. This approach is advisable if the 
selection list is static and is not to be updated. Another option 
is to link the selection list to a textfile and then import the 
values during load time. This is preferable when the selection 
list contains a large number of values that needs to be updated 
on a regular basis. The third and fourth option are to request 
the values from the Pathway server on Tandem or via a DLL 
on the PC. These approaches are useful if the selection list 
values are dynamic, meaning that they are generated or 
updated on an ongoing basis, such as exchange rates or prices 
of products or shares etc. 
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Creating a Selection List 
To create a selection list: 

1. Choose Selection Lists from the Define menu to open 
the Selection Lists dialog box. 

2. Enter the name of the new selection list in the field List 
Name. Then press Create to open the Create Selection 
List dialog box. 

3. In the Create Selection List dialog box, indicate 
whether you wish to create the list manually, import it 
from a delimited textfile, request it from a Pathway 
server or via a DLL. Note that the appearance of the 
dialog box will vary with your choice. In the following 
three sections, the creation of each type of selection list 
is described. 

Creating the Selection List Manually 
To create the selection list manually: 

1. In the Create Selection List dialog box, check the 
Manual radio button. The Create Selection List dialog 
box is depicted in the figure next page. 

2. In the Rows field, indicate the number of rows in the 
selection list. The maximum number of rows is 99. 

3. In the Columns field, indicate the number of columns 
in the selection list. The maximum number of columns 
is 2. 

4. In the Value Column field, indicate the number of the 
column that will contain the values to be displayed. 
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Figure 6.28: The Create Selection List dialog box is used when 
creating the selection list manually. 

5. Proceed to enter the selection list values in the 
Selection List Values matrix at the bottom of the 
dialog box. 

6. Click the OK button. 

Loading the Selection List from a Textfile 
To create a selection list based on a textfile: 

1. In the Create Selection List dialog box, check the 
Textfile radio button. The Create Selection List 
dialog box is depicted in the figure below. 
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Figure 6.29: The Create Selection List dialog box is used when 
basing the selection list on a textfile. 

2. Enter the path and filename of the textfile. 
Alternatively, click Browse to locate the file. 

3. Indicate in the Load Time section at what point the 
selection list shall be loaded. Options are: Always, First 
Selection, and Matterhorn Startup.  
 

Always The list will be loaded when you activate 
the field. As the user exits the field, the list 
will be unloaded, which means that it will 
not take up any memory. The next time 
the user clicks the field, the list will be 
reloaded. 

First 
Selection 

The selection list will be loaded when the 
user clicks the field the first time. With 
this option, the selection list will remain 
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loaded, which means that it will be 
available to the field while the Matterhorn 
session is active. The option, however, 
will take up more memory than the 
Always option. 

Matterhorn 
Startup 

The list will be loaded and stored when 
the user launches the Matterhorn session. 
This option implies a longer start-up 
procedure, but will ensure a faster 
execution of session, since the selection 
list does not have to be loaded when the 
user clicks the field. 

Loading the Selection List from a Tandem 
Server 

To create a selection list based on a Tandem server: 

1. In the Create Selection List dialog box, check the 
Tandem Server radio button. The Create Selection 
List dialog box is depicted in the figure next page. 

2. In the System Name field, enter the system name of 
your Tandem. 

3. In the Pathway Monitor field, enter the name of the 
relevant Pathway system. 

4. In the Server field, enter the name of the relevant 
server. 

5. In the New Arguments field, enter the argument(s) 
you wish to pass to the Tandem server when the 
selection list is activated. Click the Add button to add 
the argument to the Arguments list. Alternatively, 
press the Remove button to remove an argument from 
the list. 



S c r e e n  D e s i g n e r  

 175

 
Figure 6.30: The Create Selection List dialog box is used when 
basing the selection list on a Tandem server. 

6. Indicate in the Load Time section at what point the 
selection list is to be loaded. Options are: Always, First 
Selection, and Matterhorn Startup. (See the explanations 
previously in this chapter). 

Loading the Selection List from a DLL 
To create a selection list based on a DLL procedure: 

1. In the Create Selection List dialog box, check the DLL 
Procedure radio button. The Create Selection List 
dialog box is depicted in the figure next page. 

2. In the Library Filename field, enter the path and 
filename of the DLL. Alternatively, click Browse to 
locate the DLL 



S c r e e n  D e s i g n e r  

 176

 
Figure 6.31: The Create Selection List dialog box is used when 
basing the selection list on a DLL. 

3. In the Procedure Name field, enter the procedure to be 
executed. 

4. In the New Arguments field, enter the argument(s) 
you wish to pass to the DLL when the selection list is 
activated. Click the Add button to add the argument to 
the Arguments list. Alternatively, press the Remove 
button to remove an argument from the list. 

5. Indicate in the Load Time section at what point the 
selection list shall be loaded. Default is Always. (See 
the explanations previously in this chapter). 

Associating a Selection List with an Edit Field 
To associate a selection list with an edit field: 
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1. Select the edit field to display the Object Inspector for 
the field. 

2. In the Object Inspector, click the SelectList property 
and locate the name of the selection list (see Figure 
6.32). 

3. Set the SelectListUse property to True. 

 
Figure 6.32: Associate the Selection List 
with an edit field from the Object 
Inspector. 
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Working with Edit Fields 
You cannot create edit fields from Screen Designer, but the 
many formatting features of Screen Designer will provide a 
more user-friendly interface. In addition, Screen Designer 
allows you to use the values in edit fields in macros and DLLs, 
for instance to create statistical reports. 

Formatting Edit Fields 
To format edit fields, use the Object Inspector. To activate the 
Object Inspector, select the edit field with the mouse. This will 
produce the Object Inspector depicted in Figure 6.33. The 
properties will be described on the following pages. 

Font 
If you wish to use a new font or perhaps adjust the size of the 
current font, select Font in the Object Inspector. This will 
produce the Font dialog box. From this dialog box you may 
select a new Windows font, change the font style and the font 
size. Also, you may assign display effects such as strikeout 
and underline. Finally, you may choose between different 
colors for the text. 

FontUse 
This property determines whether or not the font face 
indicated with the Font property will be used during 
execution of the requester. Options are True and False. If you 
set the option to False, the requester will use the font defined in 
the Preferences dialog box in the Matterhorn Client. 
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Figure 6.33: The Object Inspector showing 
edit field properties. 

FontColorUse 
This property determines whether or not the font color 
indicated with the Color property will be used for the edit 
field letters during execution of the requester. Options are True 
and False. If you set the option to False, the requester will use 
the font color defined in the Preferences dialog box in the 
Matterhorn Client. 
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Color 
With this property you may change the background color of 
the edit field. To change a background color, you may either 
click the Color property and select a standard Windows color 
from the dropdown list, or you may double-click the Color 
property to open the Color dialog box. Use this dialog box to 
select a background color. If you wish to fashion your own 
colors, click the Define Custom Colors button. For more 
information about working with colors, turn to the Microsoft 
Windows User’s Guide. 

ColorUse 
This property determines whether or not the color indicated 
with the Color property will be used as background color for 
the edit field during execution of the requester. Options are 
True and False. If you set the option to False, the requester will 
use the font defined in the Preferences dialog box in the 
Matterhorn Client. 

ClickDbl 
Use the ClickDbl property to associate a function key with the 
edit field. When the user double-clicks the edit field, the 
function of the key will be executed. 

Width 
Use the Width property to change the width of the edit field. 
The unit of measurement is pixels. If you use the mouse to 
change the width, the Width property will change 
accordingly. 
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Top 
Use the Top property to change the Y-coordinate of the upper 
left corner of the edit field. If you use the mouse to drag the 
edit field, the value will change accordingly. If the object is 
located on a tabbed notebook, the Top property will reflect the 
Y-coordinate of the object’s upper-right corner relative to the 
tabbed notebook, not to the requester object. 

Left 
Use the Left property to change the X-coordinate of the upper 
left corner of the edit field. If you use the mouse to drag the 
edit field, the Left property will change accordingly. If the 
object is located on a tabbed notebook, the Left property will 
reflect the X-coordinate of the object’s upper-right corner 
relative to the tabbed notebook, not to the requester object. 

Height 
Use the Height property to change the height of the edit field. 
The unit of measurement is pixels. If you use the mouse to 
change the height, the value will change accordingly. 

ObjName 
This property will display the unique name of the edit field. 
Feel free to pick any name. The maximum length of an object 
name is 20 characters. 

Hint 
With this option you may associate a hint with the edit field. A 
hint is a piece of guiding text that will be displayed when the 
user points the mouse cursor to the edit field. The maximum 
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length of a hint is 40 characters. The hint will only be 
displayed if the HintShow property has been set to True. 

HintShow 
This property will determine whether or not the hint that you 
have entered in Hint will be displayed. Options are True and 
False. 

SelectList 
With this option you may associate a selection list with the 
current edit field. To choose a selection list, click the small 
button to the right of the property name. Locate the selection 
list and press Enter. The selection list will only be available to 
the user if the SelectListUse property has been set to True (see 
below). 

SelectListUse 
This property will determine whether or not the selection list 
will be available to the user. Options are True and False. 

EntryHist 
Use this property to assign an entry history to the edit field. By 
clicking the field, the user may view a list of the most recently 
made entries for that field. This list is called an entry history. 
Using an entry history saves time when users often make the 
same entries in specific fields. Click the small button to the 
right of the property name and locate the name of the entry 
history. 



S c r e e n  D e s i g n e r  

 183

Using entry histories is a quite flexible way of streamlining 
user inputs. An entry history is saved on a per-user basis in 
the user’s personal Matterhorn initialization file. 

If, for instance, the same edit field appears in two different 
screens, used by two different users (A and B) in two different 
departments (AA and BB), then two different entry histories 
will be generated. The entry history of user A will reflect his 
daily work, the entry history of user B will reflect her daily 
work. 

EntryHistCnt 
Enter an integer in this property. The integer determines the 
number of user inputs which should be stored and displayed 
in the entry history for this field. 

EntryHistUse 
This property will determine whether or not the entry history 
will be available to the user. Options are True and False. 

Macro 
Use this option to associate a macro with the edit field. To 
choose a macro, click the small button to the right of the 
property name. Locate the macro on the list. Only macros 
created with the Matterhorn macro language will appear on 
the list. The macro will be launched when the user double-
clicks the edit field. 
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FrameStyle 
To change the style of the frame surrounding the edit field, 
select FrameStyle from the Object Inspector. Options are: 
Normal, Protected, Raised, Lowered, 3Draised, and 3DLowered. 

Normal If you select this option, the frame will be 
drawn with simple borders. 

Protected If you select this option, the appearance of 
the field will depend on whether or not the 
field has been protected on Tandem. If the 
field is protected, the field will be 
displayed as plain text without a frame. If 
the field is editable the frame will be 
lowered.  

Raised If you select this option, the frame will be 
drawn with simple two-dimensional 
borders. It will appear raised, compared to 
other objects on the screen. 

Lowered If you select this option, the frame will be 
drawn with simple two-dimensional 
borders. It will appear countersinked, 
compared to other objects on the screen. 

3Draised If you select this option, the frame will be 
drawn with three-dimensional borders. It 
will appear raised, compared to other 
objects on the screen. 

3Dlowered If you select this option the frame will be 
drawn with three-dimensional borders. It 
will appear countersinked, compared to 
other objects on the screen. 
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Overlay Areas 
Screen Designer will depict the overlay areas of your 
requesters so you do not unintentionally insert objects in these 
areas (see Figure 6.34). Note that Screen Designer does not 
prevent you from inserting objects in an overlay area. In some 
cases, you may wish to insert an object, for instance a picture 
that is to be displayed as a wallpaper. 

In Screen Designer, the requesters that are normally displayed 
in overlay areas, will appear in a size corresponding to the size 
of the overlay area (see Figure 6.35). You cannot move objects 
outside this area. 

 
Figure 6.34: Screen Designer will display the overlay areas of requesters. 
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Figure 6.35: Requesters that are normally displayed in overlay areas during 
execution will be displayed in a size corresponding to the size of the overlay 
area. 

When Requesters Have Been Updated 
on Tandem  

Scenario: You have designed a series of requesters with Screen 
Designer and your system is running smoothly. At some point 
you need to update the requesters on the Tandem. Since the 
information Matterhorn needs to display the screen is located 
in the Screen Designer database, not in the POBJ, your changes 
will not be reflected on the designed versions of the requesters. 

In cases like this you must load the requester into Screen 
Designer once again. The message in Figure 6.36 will display.  
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Figure 6.36: Choose between designing the updated requester from 
scratch or merge the updated requester with the original design. 

You then have three options: 

! Merge the updated requester with the previously 
designed requester. 

! Design the updated requester from scratch. The 
information in the Screen Designer database related to 
the previously designed requester will be deleted. 

! Open the previously designed requester. This is 
recommendable if the update has not resulted in any 
major changes. 

When you merge the requesters, Screen Designer will insert all 
original objects in the new requester. Note that edit fields and 
fillers may hide behind the original Screen Designer objects, 
like bitmaps, buttons or multimedia objects. 



S c r e e n  D e s i g n e r  

 188

 

 

Chapter 7: 
Matterhorn Macro Language 

his chapter discusses the Matterhorn macro language, 
which is part of the Matterhorn Suite. The macro 

language enables you to create your own macros and run 
them in order to set up dynamic-data exchange (DDE) 
conversations with other applications that support DDE. In 
this chapter, you will learn about the principles of creating and 
running macros and the syntax and application of each of the 
statements available in the Matterhorn macro language. 

Note that the macro statements required for DDE and DLL 
require a MattOpen license. 

The chapter is organized as follows: 

! About Matterhorn Macro Language 

! Matterhorn Macro Statements 

! Creating a Macro in Screen Designer 

! Associating a Macro with an Object 

! Associating a Macro with the Requester Object 

T
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About Matterhorn Macro Language 
The Matterhorn macro language is an integral part of the 
Matterhorn Suite. The macro language enables you to create 
macros in Screen Designer and run them from your 
Matterhorn sessions. Matterhorn may operate both as DDE-
client and DDE-server. 

When Matterhorn will operate as client, you use Screen 
Designer for creating the macros. When Matterhorn will 
operate as server, you create the macros in another macro 
programming language making calls to the relevant 
Matterhorn sessions. 

! create macros to speed up and simplify administrative 
tasks. 

! create macros and run them from your legacy 
Pathway applications in order to set up dynamic-data 
exchange (DDE) conversations with other applications 
that support DDE. 

! create macros in the macro language of the client 
application to call your legacy Pathway applications. 

! create and run macros that calls a Windows DLL. 

! create macros that combine DLL and DDE technology. 

! Matterhorn may operate both as DDE-client and DDE-
server. 
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NOTE Note that the macro statements required for DDE and 
DLL require a MattOpen license. These statements are also 
detailed in the MattOpen Developer’s Guide. 

Types of Macros 
Using the Matterhorn macro language you may create macros 
which operate in the following ways: 

• Matterhorn operating as DDE-client, requesting data 
from any application with DDE-server capabilities, for 
instance Microsoft Word, Excel or Access, or from 
other Matterhorn sessions (see Figure 7.1). In this case, 
the entire macro is created from Screen Designer. 

Parameters passed to DDE -server
Matterhorn session

Macro executed
from requester

Data returned from DDE-server

Access database

 
Figure 7.1: Matterhorn operating as DDE-client, requesting data from 
Access. 

• Any DDE-compatible application operating as DDE-
client, requesting data from one or several Matterhorn 
sessions or from other DDE-compatible applications 
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(see Figure 7.2). In this case, the entire macro is created 
in the client application. 

• Matterhorn and the DDE-compatible application both 
operating as client and server in turn, requesting data 
from each other or from other applications that may 
operate as DDE-servers. For instance, a macro, which 
is run from a Matterhorn session, may activate a 
macro in Word, which in turn will request data from 
another Matterhorn session (see Figure 7.3). 

• Matterhorn operating as client making a call to a 
Windows DLL (see Figure 7.4). 

Parameters passed to Matterhorn
session

Matterhorn session

Data returned from Matterhorn

Macro executed
from Word. Word
operating as DDE-
client.

 
Figure 7.2: Word operating as DDE-client, requesting data from a 
Matterhorn session. 
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Matterhorn session 1

Macro executed from requester.
Macro will execute new macro
in PC application

PC application operating
as DDE-client

PC application operating
as DDE-server

Matterhorn session 2

Operating as DDE-server

 
Figure 7.3: Matterhorn macro executing a Word macro, which is 
requesting data from a second Matterhorn session. 

Parameters passed to DLL
Windows DLL

Matterhorn session

Macro calling a
dynamic link library

Data returned from DLL

 
Figure 7.4: A macro calls a Windows DLL from the requester. 
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Matterhorn Macro Statements 
The Matterhorn macro language provides the following 
statements: 

! DDEInitiate 

! DDEExecute 

! DDEPoke 

! DDERequest 

! DDETerminate 

! DDETerminateAll 

! CallDLL 

! Let 

! SetCursor 

! DoFKey 

! DSC_variables 

 
Before we proceed with the descriptions of the statements, 
however, you should study the section Parameter Types in 
Macro Statements. 



S c r e e n  D e s i g n e r  

 194

Parameter Types in DDE Statements 
On the following pages we will describe the various 
statements of the Matterhorn macro language. Each statement 
takes one or several of the following two types of parameters: 

! Integer 

! Identifier 

The Integer parameter may be any whole number between 1 
and 10.  

The Identifier parameter may be any one of the four following 
types; string, user variable, DSC variable, and edit field. 

The String Identifier 
The string identifier is a string constant. String constants must 
be enclosed in quotation marks as in “string”. If you should 
ever need to use quotation marks within a string you must use 
the “”string”” syntax. 

Note that you may also use the concatenation operator ‘&’ to 
build new strings,  “Tom ”&”Jones” = “Tom Jones”. 

The User Variable Identifier 
You may use up till 255 user variables. User variables are 
internal storage and may be used as you please. For the user 
variable identifier you use the following notation; VAR[1]. 
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The DSC Variable Identifier 
The DSC variable identifier identifies a is a descriptor in 
working storage. For DSC variables you use the following 
notation: dsc[70]. 

The Edit Field Identifier 
The edit field identifier identifies a specific edit field in the 
current requester. As you load a requester into Screen 
Designer, each edit field in the requester will have a unique 
object name assigned to it.  

Rather than referring to edit fields by screen coordinates, 
Matterhorn refers to a field by its unique object name, enabling 
the macros to locate a field no matter where it is placed on the 
screen. 

The syntax of this name is Edit<number>, as in Edit1, but you 
may change the object name. Note that the maximum length of 
an object name is 20 characters. 

DDEInitiate 
The DDEInitiate statement initiates a DDE-conversation with 
the server application and opens a DDE-channel through 
which the conversation may take place. 

When you start a DDE-conversation using DDEInitiate(), you 
reserve a channel for a specific topic recognized by the server 
application. In Microsoft Word, for example, each open 
document is a separate topic. The statement has the following 
syntax: 

DDEInitiate(Channel:Integer,Application:Identifier, 
Topic:Identifier) 
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Channel
  

The channel number used for the DDE-
conversation. From 1 to 10. 

Application The application’s EXE-file. Note that the 
application should appear from your 
PATH-statement. If the Matterhorn Client is 
to operate as DDE-server, remember that 
the application name of Matterhorn is 
Mattwin. 

Topic This parameter may either be a string 
identifying a document or a spreadsheet, 
for instance, or an edit field in the current 
Matterhorn session. 
 
Many applications that support DDE, 
including Matterhorn, recognize a topic 
named System, which is always available 
and can be used to find out which other 
topics are available. The string topic 
associated with a Matterhorn session is a 
so-called session identifier. The session 
identifier is the current  session name. 

DDEInitiate Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

DDEInitiate(1, “WINWORD”,”LETTER.DOC”) 

When the user runs the macro from the Matterhorn session, 
this statement will reserve channel 1 for DDE-conversation 
with Word and the document LETTER.DOC. If Word is not 
currently running, the macro will ask you to confirm that the 
application is launched. 
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DDEInitiate(1, Edit1,Edit2) 

To run the macro, the user must make entries for the fields 
Edit1 and Edit2 (an application name and a topic). The 
statement will then reserve channel 1 for DDE-conversation 
with the specified application name and topic and launch the 
application. 

DDEExecute 
The DDEExecute statement sends a command or series of 
commands to an application through a dynamic-data 
exchange. Use this command, for instance, to launch a Word 
macro from a Matterhorn session macro. The statement has the 
following syntax: 

DDEExecute (Channel:Integer, Command:Identifier) 

Channel
  

The channel number of the DDE-conversation 
as provided by DDEInitiate(). 

Command A command or series of commands recognized 
by the server application, for instance a macro 
or a function key. You can also use the format 
described under SendKeys to send specific key 
sequences. If the server application can’t 
perform the specified command, an error 
occurs. 

DDEExecute Exemplified 
In many applications that support dynamic-data exchange,  
Command should be one or more statements or functions in the 
application’s macro language. For example, in Microsoft Excel 
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the XLM macro instruction to create a new worksheet is 
NEW(1). To send the same command  through a DDE channel, 
you use the following instruction: 

DDEExecute (1, "[NEW(1)]") 

Note that some applications, including Matterhorn, require 
that each command (like macros) received through a DDE-
channel be enclosed in brackets. Keys and function keys must 
be enclosed in braces: 

DDEExecute(1,”{F1}”) 

You can use a single DDEExecute instruction to send more 
than one command. For example, the following instruction 
tells Microsoft Excel to open and then close a worksheet: 

DDEExecute (1, "[NEW(1)][FILE.CLOSE(0)]") 

Note that there is no space between commands in brackets; a 
space character between the commands would cause an error. 
The preceding instruction is equivalent to the following two 
instructions: 

DDEExecute (1, "[NEW(1)]") 

DDEExecute (1, "[FILE.CLOSE(0)]") 

Another example: In a Matterhorn session macro, the 
following statement appears: 

DDEExecute (1, Edit3) 

To run the macro, the user must make an entry for the field 
Edit3 (the command name) prior to launching the macro. 
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A third example: In a Word macro, the following statement 
appears: 

DDEExecute(1,”[SetCursor(Edit5)]{Return}) 

The Word macro is designed to initiate a Matterhorn session 
for DDE-conversation with Word. The SetCursor-command 
will then be executed, placing the cursor in the edit field 
identified by Edit5. Subsequently, the edit field will receive a 
Return keystroke. 

DDEPoke 
The DDEPoke statement uses an open DDE-channel to send 
data to an application. When you start a DDE-conversation 
using DDEInitiate(), you open a channel to a specific topic 
recognized by the server application. In Microsoft Word, for 
instance, each open document is a separate topic. 

When you send information to a topic in the server appli-
cation, you must specify the item in the topic you want to send 
information to. In Microsoft Excel, for instance, cells are valid 
items and are referred to using either the "R1C1" format or 
named references. DDEPoke sends data as a text string; you 
cannot send text in any other format, nor can you send 
graphics. 

The statement has the following syntax: 

DDEPoke (Channel:Integer, Item:Identifier, 
Data:Identifier) 

Channel
  

The channel number of the DDE-
conversation, as provided by DDEInitiate(). 
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Item An item within a DDE-topic. If the server 
application does not recognize Item, an error 
occurs. In Word, an item may be a bookmark 
field 

Data The data to be sent to the server application. 

DDEPoke Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

DDEPoke(1, “NAME”,Edit4) 

The statement will use channel 1, which has previously been 
reserved for a DDE-conversation with Word and the 
document LETTER.DOC. The contents of Edit4 in the 
Matterhorn session will then be transferred to the bookmark 
field NAME in the Word document. 

DDERequest 
The DDERequest statement uses a DDE-channel to request an 
item of information from a server application and transfer it to 
the client application. When you start a DDE-conversation 
using DDEInitiate(), you reserve a channel for a specific topic 
recognized by the server application. In Microsoft Word, for 
instance, each open document is a separate topic. 

When you request information from the topic in the server 
application, you must specify the item in the topic whose 
contents you are requesting. In Microsoft Excel, for example, 
cells are valid items and they are referred to using either the 
"R1C1" format or named references. 
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DDERequest() returns data as a text string only; if the function 
is unsuccessful, it returns an empty string (""). Text in any 
other format cannot be transferred, nor can graphics. 

The statement has the following syntax: 

DDERequest (Channel:Integer, Field 
Name:Identifier, Item:Identifier) 

Channel
  

The channel number of the DDE-
conversation as provided by DDEInitiate(). 

Field Name The edit field in the Matterhorn session, 
where the requested data will be inserted. 
The edit field may also be identified by a 
descriptor from working storage or a user 
variable. 

Item The item within a DDE-topic recognized by 
the server application. DDERequest() returns 
the entire contents of the specified item. If the 
server application doesn’t recognize Item, an 
error occurs. 

DDERequest Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

DDERequest (1, Edit5, “NAME”) 

When the macro is executed, the statement will use the open 
DDE-channel to request the content of the item “NAME” and 
insert it in the edit field identified by Edit5 in the Matterhorn 
session. 
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Matterhorn and other applications that support DDE 
recognize a topic named System. Three standard items in the 
System topic are described below. Note that you can get a list 
of the other items in the System topic using the item SysItems. 

SysItems 
Returns a list of all items in the System topic. 
 
Topics 
Returns a list of available topics. 
 
Formats 
Returns a list of all the Clipboard formats supported by the 
server application. 

DDETerminate 
The DDETerminate statement closes the specified dynamic-
data exchange (DDE) channel. To free system resources, you 
should close channels you aren’t using. The statement has the 
following syntax: 

DDETerminate(Channel:Integer) 

Channel
  

The channel number of the DDE-
conversation as provided by DDEInitiate(). 

DDETerminate Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

DDETerminate(1) 
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The statement closes the DDE-conversation that has previous-
ly been reserved by channel 1. 

DDETerminateAll() 
The DDE TerminateAll statement closes all dynamic-data 
exchange (DDE) channels opened by Matterhorn. Using this 
statement is the same as using a DDETerminate statement for 
each open channel. DDETerminateAll does not cause an error 
if no DDE channels are open. 

If you interrupt a macro that opens a DDE channel, you may 
inadvertently leave a channel open. Open channels are not 
closed automatically when a macro ends, and each open 
channel uses  system resources. The statement has the 
following syntax: 

DDETerminate() 

CallDLL 
The CallDLL statement enables you to call a dynamic link-
library from a Matterhorn session macro. The statement 
requires a MattOpen license. The statement has the following 
syntax: 

CallDLL(DLLName,DLLProcedure,Param1,….ParamN, Identifier) 

DLLName Name of dynamic link library to be called. 
The DLL name may also be identified by a 
descriptor from working storage or a user 
variable. 
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DLLProcedure Name of procedure to be executed. The 
procedure name may also be identified by 
a descriptor from working storage or a 
user variable. 

Parameter The edit field(s) in the Matterhorn session 
whose contents will be processed during 
the call. The fields may also be identified 
by descriptors from working storage or 
user variables. 

Identifier See the section Parameter Types in DDE 
Statements. 

CallDLL Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

CallDLL(“TEST.DLL”,”TESTFUNC”,Edit1,Edit2) 

The statement will call the dynamic link library TEST.DLL and 
execute the procedure TESTFUNC with the contents of the 
Matterhorn session fields Edit1 and Edit2. 

Let 
The Let statement enables you to place a value in an edit field 
or save an edit field value in a variable and then use this value 
in a later screen. Also, the Let statement enables you to assign 
a working storage value to an edit field. The statement has the 
following syntax: 

Let Identifier=Value 
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Identifier may be either an edit field, a variable or a descriptor. 
Value may be either an edit field, a variable, a descriptor or a 
fixed string. 

Let Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

Let Edit1=“MATTCONF” 

The statement will insert the string MATTCONF in the edit 
field Edit1. 

SetCursor 
The SetCursor statement places the cursor in an edit field. The 
statement has the following syntax: 

SetCursor (Edit field) 

Edit field refers to the edit field. 

SetCursor Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

SetCursor (Edit1) 

This statement will place the cursor in the edit field Edit1, no 
matter where it is located on screen. 
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DoFKey 
DoFKey enables you to launch a Tandem terminal key from 
the macro. The statement has the following syntax: 

DoFKey (“FKey”) 

FKey is a Tandem terminal key. 

DoFKey Exemplified 
In a Matterhorn session macro macro, the following statement 
appears: 

DoFKey (“F3”) 

This statement will launch the terminal key F3. 

DSC_variables 
The DSC-statement enables you to retrieve a descriptor value 
from the Tandem working storage. The statement has the 
following syntax: 

DSC_number 

DSC-variables Exemplified 
In a Matterhorn session macro, the following statement 
appears: 

DSC_127 

This statement will get the value from the working storage 
section variable 127. To locate the descriptor number, compile 
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the Screen Cobol source file with Map option. This will list the 
variables and their descriptor numbers. 

Creating a Macro in Screen Designer 
The Matterhorn macro language is an integral part of Screen 
Designer, which means that Screen Designer is the develop-
ment tool you use when creating macros. It is also from Screen 
Designer that you associate the macros with the objects of a 
requester. 

Creating the Macro 
Start Screen Designer and load a requester into the main work 
area. Once a requester is loaded into Screen Designer, the 
Define menu becomes accessible and your are ready to create 
the macro: 

1. Select Define, Macro to open the Macro dialog box 
(see Figure 7.5). 

2. In the Macro Name field, enter a name for the new 
macro. If you wish to modify an existing macro, locate 
the macro name in the list. Depending on your choice, 
you will open the Edit Macro dialog box or Create 
Macro dialog box (see Figure 7.6). 

3. In the Macro Description field, enter the relevant 
macro statements. 

4. Click the OK button. 
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Figure 7.5: The Macro dialog box. 

 
Figure 7.6: Enter the macro Statements in the Macro Definition field. 
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For more information about how to associate a macro with a 
button, turn to the section Associating a Macro with an Object. 

Associating a Macro with an Object 
In Screen Designer you may associate a macro with the 
following types of objects: 

Buttons Click the button to launch the macro. 

Edit fields Double-click the edit field to launch the 
macro. 

Pictures Click the picture to launch the macro. 

Multimedia 
objects 

Click the multimedia object to launch the 
macro. 

Requester 
object 

The macro will be executed as the user 
performs an accept of the screen, for 
instance when exiting or updating the 
requester or moving on to another 
requester. 

Associating the Macro with an Object 
A macro may be associated with the object when creating or 
formatting the object in Screen Designer. To insert a new object 
and associate it with a macro: 

1. From the Object menu, select the relevant Insert 
command, or click the corresponding button on the 
tool bar. 
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2. A blank object will be inserted at the centre of the 
main work area. 

3. Use the associated Object Inspector to format the 
object (see Figure 7.7). 

 
Figure 7.7: Associate the macro with 
the object from the Object Inspector. 

4. Click the small arrow to the right of the Macro 
property name to display a list of available macros. 
Scroll down the list until you’ve located the desired 
macro. 
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Associating a Macro with the Requester Object 
If you associate the macro with the requester object, you can 
have the requester launch the macro as the user performs an 
accept of the screen, for instance when exiting or updating the 
requester or moving on to another requester. As an example, 
you may write a macro that inserts default values in specific 
fields of the following requester as the user proceeds to this 
requester. 

To associate a macro with the requester object: 

1. Click anywhere in the background of the requester to 
open the Object Inspector of the requester object. 

2. Click the small button to the right of the OnAccept 
property name and locate the macro on the list. 
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Figure 7.8: Associate the macro 
with the requester object from the 
Object Inspector. 

Testing the Macro 
To test the macro, run the Matterhorn session, by clicking the 
relevant icon in your Matterhorn group folder. Locate the 
relevant object and launch the macro. 

If you experience problems, open the Messages window. This 
window displays error messages that may assist you in 
debugging the macro. 
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Chapter 8: 
Data Explorer 

his chapter describes the productivity tool Data Explorer, 
which is a part of your Screen Designer package. Use 

Data Explorer to monitor and maintain your Screen Designer 
databases on a large scale. 

The chapter is organized as follows: 

! About Data Explorer 

! Installing Data Explorer 

! Starting Data Explorer 

! The Data Explorer Application Window 

! Navigating Data Explorer 

! The Menus 

! The Tool Bar  

 

 
 

T
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About Data Explorer 
The Data Explorer productivity tool provides a fast and easy 
way of monitoring and maintaining your Screen Designer 
databases on a large scale. 

Data Explorer provides a structured overview of your Screen 
Designer databases. You may create entirely new databases 
and construct them on the basis of existing databases. Thus, 
you may drag requesters from one database and drop them in 
another database. Using Data Explorer, you may drag selected 
objects from one requester to another and from one database 
to another - a technique known from Microsoft Explorer. 

Data Explorer allows you to create multiple requester layouts 
on the fly and preview your screens. Data Explorer will also 
help you rebuild or reindex your databases in case of disk or 
file errors. 

You can launch Screen Designer directly from Data Explorer to 
perform online screen editing. A click in the menu and Screen 
Designer will display the current requester. This feature also 
enables you to preview and monitor the changes you make to 
the databases using Data Explorer. 

Data Explorer enables you to move from test to production in 
a matter of seconds. Simply drag your changes from the test 
database to the production database and users will be up and 
running instantly. 

Installing Data Explorer 
Data Explorer is part of your Screen Designer package. The 
Data Explorer icon will be created as you create the Screen 
Designer icon. For more information about installing Screen 
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Designer and creating a Screen Designer icon, turn to Chapter 
2, Installing Screen Designer. 

Starting Data Explorer 
To start Data Explorer, click the Data Explorer icon. 
Alternatively, select Launch Data Explorer from the File 
menu in Screen Designer. 

The Data Explorer Application Window 
Figure 8.1 depicts the Data Explorer application window. This 
window is your work place when working with Screen 
Designer databases. The application window consists of the 
main work area, the menu bar, and the tool bar. 

 
Figure 8.1: The Data Explorer application window. 
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The Main Area 
When you load a database into Data Explorer, it will be loaded 
into the main area. In many ways, the main area of Data 
Explorer resembles the Microsoft Explorer. Each element (user 
group, requester, object, or subobject) is represented by an 
icon. 

The Data Explorer Menu Bar 
The menu bar runs just below the title bar. The menu bar 
holds all of Data Explorer’s pull-down menus that will help 
you manage your Screen Designer databases. The section The 
Menus in this chapter describes the operation of each menu 
and menu option. 

The Data Explorer Tool Bar 
The tool bar runs just below the menu bar. The tool bar 
consists of icons each representing a tool or option which you 
can use in Data Explorer. The section The Tool Bar in this 
chapter describes the operation of each icon in the tool bar. 

Navigating Data Explorer 
In many ways, the look and feel of Data Explorer resemble the 
Microsoft Explorer. Like Microsoft Explorer, the main area is 
divided into a left- and right-hand side. The design provides 
easy access to all parts of the database. The contents of 
whatever is active in the left-hand side of the main area will be 
displayed in the right-hand side. 
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Element Levels in Data Explorer 
On the top level of the element structure, you find the Screen 
Designer databases containing one or several user groups. 
Each user group is represented by a green database icon. 

Each user group contains one or several requesters and a 
special system element containing information about selection 
list, macros, requester remappings, and keyboard mappings. 
These elements are depicted on the next level. 

On the third level - the object level - you find the various 
object types represented by icons: text objects, edit fields, 
buttons, frames, pictures, selection lists, multimedia objects, 
tabbed notebooks, etc. When an object is selected in the left-
hand side of the main area, the Object Inspector will display 
the properties of that object. 

 
Figure 8.2: In Data Explorer, each element is represented by an icon. 
Clicking an icon will expand elements beneath the current level. 
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Note that you may customize Data Explorer to expand 
requesters and objects or not when you click them. For more 
information, turn to the section, The Database Menu. 

When you click an element, the window will expand to 
display any subelements of that element. Thus, when you click 
a requester icon, the objects of that requester will be displayed 
on a list of object icons (see Figure 8.2). And when you click an 
object, the Object Inspector will display the properties of that 
object (see Figure 8.3). 

Note that picture objects and tabbed notebooks contain several 
subobjects. These subobjects contain data which are relevant to 
the parent object (the picture or the tabbed notebook), but not 
to the person using Data Explorer. You cannot edit or 
manipulate these subobjects in any way. If you copy (or move) 
a picture or a tabbed notebook to a new location, the 
subobjects will also be copied (or moved). 
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Figure 8.3: Data Explorer will display the properties of screen objects. Note 
that you cannot edit object properties from Data Explorer. 
 

You may customize Data Explorer to display these subobjects 
by checking the Show Subobjects check box in the 
Preferences dialog box. For more information, turn to the 
section, The Database Menu. 

 
Figure 8.4:  A tabbed notebook with subobjects. 

Working With Several Databases 
As mentioned, Data Explorer allows you to work with several 
databases at a time. Each database will open in a separate 
window in the main area. Data Explorer lets you arrange all 
open databases, tiled or cascaded. You may then drag 
requesters and/or objects from one database to another using 
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the mouse, and you may switch from one database to another, 
simply by clicking in the new database window (see Figure 
8.5). 

 
Figure 8.5: Data Explorer allows you to work with several open databases 
at a time. 

Dragging and Dropping Elements 
One of the powerful features of Data Explorer is the ability to 
drag elements from one location and then drop them in 
another location. Note that dropping an element is the 
equivalent of copying that element with all its properties 
preserved. 

As mentioned you may drag selected objects from one 
requester to another, and from one database to another. In 
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addition, you may drag requesters from one database and 
drop them in another database. 

Note that you can also use the Cut-, Copy- and Paste 
commands when rearranging, moving and copying elements 
in Data Explorer. 

To drag and drop an element: 

1. Select the element with the mouse and press down the 
left mouse button. 

2. Move the mouse to the location where you wish to 
drop the element. As you move the mouse, the cursor 
transforms into one of two drag-and-drop symbols, 
each indicating whether or not the element may be 
dropped. If the cursor transforms into a stop sign you 
cannot drop the icons. 

3. When the cursor is over the destination element, 
release the mouse button. 

Note that the changes you make to your databases by 
dragging and dropping will be implemented instantly. If you 
regret a drag-and-drop procedure, you can undo it by deleting 
the element which you have just copied from the destination 
element. 

Moving Objects Between Data Explorer and 
Screen Designer 

Using the Cut-, Copy- and Paste commands, you can copy and 
move elements from Screen Designer to Data Explorer, and 
vice versa. 

In Screen Designer, select the object with the mouse and pick 
Cut or Copy from the Edit menu. Proceed to Data Explorer 
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and locate the target requester. Select Paste from the Edit 
menu to insert the object. The object will be inserted at the 
bottom of the object list. 

In Data Explorer, select the object on the object list and pick 
Cut or Copy from the Edit menu. Proceed to the Screen 
Designer application window and select Paste from the Edit 
menu. The object will be inserted on the screen in accordance 
with its object properties. 

 
Figure 8.6: You may move and copy objects from Screen Designer to Data 
Explorer and vice versa. 

Dragging an Element to Multiple Elements 
Data Explorer allows you to mass reproduce one or several 
selected elements by copying them to other elements. For 
instance, you may copy the same button to several target 
requesters. 

This powerful feature enables you to create template 
requesters and then use the templates as a basis for creating 
new requesters. 
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To copy a button to multiple requesters in another database: 

1. Open Database1 and Database2 and make sure to 
arrange the windows so that both databases show. 

2. Locate and select the button in Database1. 

3. Locate and select the target requesters in Database2. 

4. Drag the button and drop it over the requesters in 
Database2. 

 
To copy a button to multiple requesters in the same database: 

1. If Database1 is already open, select New Window 
from the Window menu. Arrange the windows so that 
both source and target elements show. 

2. Locate and select the source button in Window1. 

3. Locate and select the target requesters in Window2. 

4. Drag the button and drop it over the requesters in 
Window2. 

Selecting Elements in Data Explorer 
Before you can drag and drop elements in Data Explorer, you 
must select them with the mouse. 

To select an element: 

• Point the mouse to the element and click with the left 
mouse button. The element will be highlighted, 
indicating that it is selected. 

To select a block of adjacent elements: 
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• Press down the Shift-key and point the mouse to the 
first element in the block and click with the left mouse 
button. Then point the mouse to the last element in the 
block and click. The entire block will be highlighted, 
indicating that the elements have been selected. 

To select multiple non-adjacent elements: 

• Press down the Ctrl-key and point the mouse to the 
first element and click with the left mouse button. The 
element will be highlighted, indicating that it has been 
selected. Whilst pressing down the Ctrl-key, proceed 
to click the other elements. 

Note that you can use the Select All command from the Edit 
menu to select all elements in the right-hand side of the main 
area. 

The Menus 
The menu bar runs just below the title bar. The menu bar 
holds all of Data Explorer’s pull-down menus that will help 
you to monitor and maintain your databases. This section 
takes you through the menus and menu options of the Data 
Explorer menu bar. 

The Database Menu 
The Database menu provides three different options: 

! New Database 

! Open Database 

! Preferences 
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! Exit 

! Recently Used Databases List 

New Database 
To create a new Screen Designer database, select New 
Database from the Database menu. In the New Database 
dialog box, select a location and enter the name of the new 
database. Screen Designer databases are saved as .db3 file 
types. An empty database window opens. You may now drag 
elements from other databases to this database to create 
entirely new screens. 

Open Database 
To open an exiting Screen Designer database, select Open 
Database from the Database menu. In the Open Database 
dialog box, locate the database and click Open. 

Preferences 
To open the Preferences dialog box, select Preferences from 
the Database menu. In the Preferences dialog box, you may 
customize Data Explorer on various levels.  

Recently Used 
Databases List  

To change the number of databases 
listed in the Database menu, enter a 
number from 1 to 16 in the Entries 
box. 

Expand Requesters This check box lets you configure 
whether or not requester and object 
icons will expand to show the 
underlying elements (objects and 
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object properties, respectively) when 
you click them. 

If the Expand Requesters check box 
is checked and you click a requester 
icon, the objects of the requester will 
display. And if you click an object 
icon, the Object Inspector will open 
displaying the properties of that 
object. 

If the Expand Requesters check box 
is not checked, the requesters and 
objects will not expand as you click 
their icons. 

 
Figure 8.7: The Preferences dialog box. 

Show Subobjects Picture objects and tabbed notebooks 
contain several subobjects. These 
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subobjects contain data which are 
relevant to the parent object (the 
picture or the tabbed notebook), but 
not to the person using Data 
Explorer. 

Check this option if you wish to see 
the subobjects of the pictures and 
tabbed notebook in your requesters. 

Preserve Object 
Names 

 

Checking this box implies that object 
names (the entry in the ObjName 
property) will be preserved as you 
copy the objects from one location to 
another. 

The option is useful in cases when 
the destination (database or 
requester) contains objects with 
names which are identical to the 
objects you are copying. The option 
controls whether or not the objects at 
the destination should be overwritten 
by the objects which are copied. 

Checking the option implies that 
objects with similar object names will 
be overwritten by the objects you are 
copying. 

If you leave the check box 
unchecked, the objects will be given 
new object names. If, for instance, 
you copy Button1, -2, and -3 from 
one requester to another requester 
containing Button1, -2, and -3, then 
the new objects will be assigned the 
object names Button4, -5, and -6. 
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Program File Use this field to enter a path to a 
Screen Designer program file. Click 
Browse to browse for the file. To 
launch Screen Designer, you must 
select Launch Screen Designer in the 
Tools menu. 

Profile Use this field to enter a path to a 
Matterhorn profile. Click Browse to 
browse for the profile. To launch 
Screen Designer you, must select 
Launch Screen Designer in the 
Tools menu. 

OK Click OK to confirm the settings in 
the Preferences dialog box. 

Cancel Click Cancel to annul any changes 
made in the Preferences dialog box. 

Exit 
To exit Data Explorer, select Exit from the Database menu. 

Recently Used Databases List 
At the bottom of the Database menu you will see the names of 
the most recently loaded databases. Select the database name 
with the mouse to open the database. 

The Edit Menu 
Using the commands in the Edit menu you may cut, copy, 
paste and delete database elements and select all elements. 
The Edit menu provides these options: 
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! Cut 

! Copy 

! Paste 

! Delete 

! Select All  

Cut 
Use this command to cut the selected elements from Data 
Explorer to the Clipboard. Alternatively, press Ctrl+X. 
Elements which have been cut may be pasted into other 
elements, also if the elements are located in other databases. 
Note that you may also gain access to this command by right-
clicking the mouse anywhere in the Data Explorer main area. 

Also note that you may drag and drop elements in Data 
Explorer. For more information, turn to the section Dragging 
and Dropping Elements. 

Copy 
Use this command to copy the selected elements in Data 
Explorer into the Clipboard. Alternatively, press Ctrl+C. 
Elements which have been copied may be pasted into other 
elements, also if the elements are located in other databases. 
Note that you may also gain access to this command by right-
clicking the mouse anywhere in the Data Explorer main area. 

Also note that you may drag and drop elements in Data 
Explorer. For more information, turn to the section Dragging 
and Dropping Elements. 
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Paste 
Use this command to paste the contents of the Clipboard into 
the current database. Alternatively press Ctrl+V. Note that 
you cannot paste edit fields. Also note that you cannot paste 
selection lists, macros, etc. within the same database. Note that 
you may also gain access to this command by right-clicking 
the mouse anywhere in the Data Explorer main area. 

Also note that you may drag and drop elements in Data 
Explorer. For more information, turn to the section Dragging 
and Dropping Elements. 

Delete 
To delete an element from the Screen Designer database, select 
Delete from the Edit menu. You cannot restore an element 
once it has been deleted. Neither can you delete a user group 
or a database with this command. 

Note that you may also gain access to this command by right-
clicking the mouse somewhere in the Data Explorer main area. 

Select All 
Use the Select All command to select all elements in the active 
window. For more information on selecting elements, turn to 
the section Selecting Elements in Data Explorer.  

The Requester Menu 
The Requester menu contains two menu options: 

! Preview 

! New Group 

! Launch Screen Designer 
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Preview 
Use this command to preview the requesters one by one. Note 
that you may also gain access to this command by right-
clicking the mouse somewhere in the Data Explorer main area. 

New Group 
To create a new user group, select New Group from the 
Requester menu. In the New Group dialog box, enter a new 
group name. A user group icon will be inserted at the bottom 
of the list in the Data Explorer application window. 

Launch Screen Designer 
Use this command to launch Screen Designer from within 
Data Explorer. Screen Designer will open in a separate Screen 
Designer application window. This powerful feature provides 
easy access to online screen editing and also helps you 
preview and monitor the changes you make to the databases 
using Data Explorer. 

Before activating this command, make sure that the Program 
File and Profile fields in the Preferences dialog box contains 
valid paths to the Screen Designer program file and the 
Matterhorn profile you wish to use. The Preferences dialog 
box is available from the Databases menu. 

Note that you may also gain access to this command by right-
clicking the mouse somewhere in the Data Explorer main area. 

The Tools Menu 
The Tools menu provides four options for maintaining your 
Screen Designer databases: 
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! Refresh Window 

! Refresh All 

! Rebuild 

! Reindex 

! Convert DAT to DB3 

! Take Snapshot 

! Restore Snapshot 

! Backup 

Refresh Window 
Use the Refresh Window command to refresh the current 
database in Data Explorer. Since the changes you make to your 
requesters in Screen Designer will not be immediately 
implemented in Data Explorer the command is useful when 
you are moving and copying elements between Data Explorer 
and Screen Designer. The Refresh Window command will 
load the most recently saved version of the database in Data 
Explorer. 

Refresh All 
Use the Refresh All command to refresh all open databases in 
Data Explorer. Since the changes you make to your requesters 
in Screen Designer will not be immediately implemented in 
Data Explorer the command is useful when you are moving 
and copying elements between Data Explorer and Screen 
Designer. The Refresh All command will load the most 
recently saved versions of the databases in Data Explorer. 
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Rebuild 
To rebuild the database, select Rebuild from the Tools menu. 
The command implies that the database will also be reindexed. 
If the operation was not successful, you will receive an error 
message. 

Reindex 
To reindex the database, select Reindex from the Tools menu. 

Convert DAT to DB3 
To convert a Screen Designer database version 1.0 to version 
5.0, select Convert DAT to DB3 from the Tools menu. Screen 
Designer 1.0 databases have the extension .tab and versions 5.0 
have the extension .db3. 

Take Snapshot 
Use the Take Snapshot command to take a snapshot of the 
database. The feature enables you to "revert" to a previously 
saved version of the database. You may take as many 
snapshots as you wish, but only the 9 most recent snapshots 
can be restored. Each snapshot will be stored in a separate slot. 

If you click the Take Snapshot button on the tool bar, Data 
Explorer will store the snapshot in the next available slot. If no 
slots are available, Data Explorer replaces the oldest snapshot 
with the new snapshot. 
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Restore Snapshot 
Use the Restore Snapshot command to restore a snapshot. 
Scroll down the pulldown menu and select the snapshot you 
wish to restore. 

Backup 
To perform a backup of the database, select Backup from the 
Tools menu.  

The Window Menu 
The Window menu lets you customize the way windows are 
arranged in the main area. The menu provides the following 
options: 

! New Window 

! Tile Horizontally 

! Tile Vertically 

! Cascade 

New Window 
To open a new window containing the current database, select 
New Window. Use this option to obtain a clearer view of 
larger databases, for instance when you are dragging and 
dropping from one area of the database to another area of the 
same database which is not visible with just one open window.  
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Tile Horizontally 
To tile open windows horizontally, select Tile Horizontally 
from the Window menu. 

Tile Vertically 
To tile open windows vertically, select Tile Vertically from the 
Window menu. 

Cascade 
To rearrange all open windows so they overlap in a cascade, 
select Cascade from the Window menu. 

 
Figure 8.8: Cascading database windows in Data Explorer. 
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The Tool Bar 
The tool bar runs just below the menu bar. For your 
convenience, you may use these tool and function buttons 
instead of the menu options. 

 
Figure 8.9 The Data Explorer tool bar. 

These are the tool and function buttons in Screen Designer: 

! Open Database 

! Cut 

! Copy 

! Paste 

! Delete 

! Preview 

 

Open Database To open a database, click the Open 
Database button. Locate the name of the 
database in the Open Database dialog box 
and click the OK button. 

Cut To cut the selected elements from Data 
Explorer to the Clipboard, click the Cut 
button. Elements which have been cut may 
be pasted into other elements, also if the 
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elements are located in other databases. 
Also note that you may drag and drop 
elements in Data Explorer. For more 
information, turn to the section Dragging 
and Dropping Elements. 

Copy To copy the selected elements from Data 
Explorer to the Clipboard, click the Copy 
button. Elements which have been copied 
may be pasted into other elements, also if 
the elements are located in other databases. 

Also note that you may drag and drop 
elements in Data Explorer. For more 
information, turn to the section Dragging 
and Dropping Elements. 

Paste To paste the contents of the Clipboard into 
the current database, click the Paste button. 
Note that you cannot paste edit fields.  

Also note that you may drag and drop 
elements in Data Explorer. For more 
information, turn to the section Dragging 
and Dropping Elements. 

Delete 

 

To delete an element, click the Delete 
button. You cannot restore an element once 
it has been deleted. Neither can you delete 
a database with this command. 

Preview To preview the current requester, click the 
Preview button. Note that the requester 
must be selected in the right-hand side of 
Data Explorer main area. 
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Glossary 
DDE Dynamic Data Exchange (DDE). A 

tool for sharing information 
between programs under 
Windows. Two Windows 
programs carry on a DDE 
conversation by posting messages 
to each other. These two programs 
are knows as the ‘server’ and the 
‘client’. A DDE server is the 
program that has access to data 
that may be useful to other 
Windows programs. A DDE client 
is the program that requests and 
obtains this data from the server. 

Entry History 

 

An entry history is a list of the 
entries, or inputs, most recently 
made for a particular edit field. 
When you activate the option for a 
field in Screen Designer, the entry 
history will be displayed when the 
user clicks the field during 
execution. This will save time if the 
user often makes the same entries 
in specific fields. Using entry 
histories is a quite flexible way of 
streamlining user inputs. 
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An entry history is saved on a per-
user basis in the user’s personal 
Matterhorn initialization file. If, for 
instance, the same edit field 
appears in two different screens, 
used by two different users (A and 
B) in two different departments 
(AA and BB), then two different 
entry histories will be generated. 
The entry history of user A will 
reflect his daily work, the entry 
history of user B will reflect her 
daily work. 

Initial Requester The initial requester is the first 
requester to be called in a session. 

MATT-CONF 

 

The Matterhorn Configuration 
server. This server will handle and 
store the configuration information 
related to each Pathway 
application that is to be executed as 
a Matterhorn session. 

MATT-POBJ The Matterhorn POBJ server.  This 
server will transfer the code of the 
requester to the PC. The 
Matterhorn Client will then execute 
the code on the PC. For more 
information about the operation of 
MATT-POBJ, turn to the 
Matterhorn Installation and Setup 
Guide. 
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Matterhorn 
Configuration 

The Matterhorn Configuration 
program is the obligatory tool you 
must use when preparing your 
company’s Pathway requesters to 
be executed as Matterhorn sessions. 
Three fields are relevant when 
using Screen Designer and running 
redesigned versions of your 
requesters. They are all located in 
the Miscellaneous section: Use 
Screen Designer Layout, Screen 
Designer User Group and Screen 
Designer Database Location. 

Dataexpl.exe The Data Explorer executable file. 

Designer.exe The Screen Designer executable 
file. 

Mattwin.exe The executable file of the 
Matterhorn Client. 

Mattwin.ini The filename of the Matterhorn 
profile which is part of your 
Matterhorn package. You must 
create a profile for each of your 
Matterhorn sessions. The profile 
provides the Matterhorn Client 
executable file, Mattwin.exe and 
the Screen Designer executable file, 
Designer.exe with information 
necessary to address the Tandem 
system and the Matterhorn 
Pathway system.  

Object Inspector Screen Designer objects are 
formatted by means of the Object 
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 Inspector. The Object Inspector 
displays all properties of the 
currently selected object(s) like font 
selection, size, on-screen position 
etc. in a separate window. 

POBJ The Screen Cobol program libraries 
containing the object codes of your 
requesters.  

RSC 

 

The Remote Server Call (RSC) allows 
workstations to access Pathway 
servers and other Guardian 90 
processes on the Tandem. RSC 
enables you to implement powerful 
client-server applications. 

Screen Cobol A procedural language that is used 
to define and control terminal 
displays. 

Selection List 

 

A selection list is a fixed number of 
valid entries which can be used for 
a specific field. For instance, you 
may associate all valid zipcodes 
with a Zipcode field or all valid 
currency codes with a Currency 
Code field. When users click these 
fields, the valid values will be 
displayed in a dropdown list box. 

Session Name 

 

The Session Name is a unique 
name identifying the current 
Screen Designer or Matterhorn 
session on both the Tandem and 
the PC. Screen Designer and 
Matterhorn both use the Session 
Name entry in the Matterhorn 
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profile to locate the corresponding 
Session Name on Tandem. 

Session Setup Window in Matterhorn 
Configuration in which you may 
create your Matterhorn sessions. 

Session Survey Survey window in Matterhorn 
Configuration which will list all 
available Matterhorn sessions. 

Screen Designer 
Database 

 

When using Screen Designer, you 
create and relate a database of 
information to the object code of 
your Tandem requesters. The 
database will store information 
about advanced screen layout, 
available selection lists, macros etc. 
Subsequently, Matterhorn will use 
the information in the database as a 
basis of displaying the screen when 
you execute the requester as a 
Matterhorn session. This database 
may be located either on the 
Tandem or on the PC. 

Screen Designer 
Object 

 

As you will learn, the term object is 
a core term in Screen Designer. The 
basic objects are edit fields (known 
as fields on the Tandem) and text 
fields (known as fillers on the 
Tandem). In addition, you may use 
Screen Designer to add new objects 
to your screens, including frames, 
push buttons, graphics, multimedia 
objects, and tabbed notebooks. 
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Index 

6 
6530/3270-sessions, 18 

A 
ActKey, 134 
associating 

button with multimedia, 137 
button with shortcut key, 134 
hint with edit field, 181 
hint with picture, 145 
macro with button, 137, 143, 

156 
macro with edit field, 183 
macro with object, 209 
multimedia with button, 157 
multimedia with picture, 144 
multimedia with pictures, 158 
selection list with edit field, 

176 

B 
backgrounds, 26, 121, 124 
button 

associate with macro, 209 
ButtonPanelShow, 120 
buttons, 24, 25, 73, 131 

ActKey, 134 

associate with multimedia, 
157 

Caption, 134 
Click, 133 
creating, 132 
Font, 134 
FontUse, 135 
formatting, 132 
Height, 136 
Hint, 138 
HintShow, 138 
inserting, 132 
Left, 136 
Macro, 137, 143, 156 
MMFile, 137 
MMObject, 137 
MMSelect, 137 
Object Inspector, 132 
ObjName, 133 
Top, 136 
URL, 138 
URLUse, 139 
Width, 136 

C 
CallDLL (statement), 203 
canvas, 63, 114, 161 
Caption 

buttons, 134 
text objects, 127 
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Click 
buttons, 133 
multimedia objects, 155 

ClickDbl 
edit fields, 180 
pictures, 141 

Color, 121 
edit fields, 180 
text objects, 128 

ColorUse, 122 
edit fields, 180 
text objects, 129 

Copy (command), 68 
copying 

objects, 109, 220 
creating 

macro, 80 
multimedia objects, 150 
objects, 105 
selection list, 79 
selection lists, 171 

Cut (command), 68 
cutting 

objects, 109 

D 
Data Explorer, 35, 54, 213–37 

application window, 215 
Backup (command), 234 
Cascade (command), 235 
Convert DAT to DB3, 233 
Copy (command), 229 
copying objects, 220 
copying requesters, 220 
Cut (command), 229 
Database menu, 224 
Delete (command), 230 
deleting objects, 230 
deleting requesters, 230 
installing, 214 

Launch Screen Designer 
(command), 231 

launching from Screen 
Designer, 67 

levels in, 217 
menu bar, 224 
moving objects, 220 
moving requesters, 220 
New Database (command), 

225 
New Window (command), 

234 
Open Database (command), 

225 
Paste (command), 230 
Preview (command), 231 
Rebuild (command), 233 
Refresh (command), 232 
Reindex (command), 233 
Requester menu, 230 
Screen Designer, 221 
Select All (command), 230 
selecting elements, 223, 230 
Snapshot (command), 233, 

234 
Tile Horizontally (command), 

235 
Tile Vertically (command), 

235 
tool bar, 236 
Tools menu, 231 

database, 53 
location, 48 
setting up, 53 

DDE, 189 
set up DDE conversation, 13 

DDE statements 
DSC variable identifier, 195 
edit field identifier, 195 
parameter types in, 194 
string identifier, 194 
user variable identifier, 194 
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DDE-client, 190 
DDEExecute (statement, 197 
DDEInitiate (statement), 195 
DDEPoke (statement), 199 
DDERequest (statement), 200 
DDETerminate (statement), 202 
DDETerminateAll() (statement), 

203 
Define menu, 76–83 
Delete (command), 69 
deleting 

elements, 230 
objects, 112, 230 

DLL, 81, 171 
DoFKey (statement), 206 
double-clicks, 33 
dragging 

elements, 220 
in Data Explorer, 223 
multiple elements, 222 
objects, 220 
requesters, 214, 220 

dropping 
in Data Explorer, 220 

DSC_variables, 206 

E 
edit field 

and selection list, 176 
associate with macro, 209 
Macro, 183 

edit fields, 178 
ClickDbl, 180 
Color, 180 
ColorUse, 180 
EntryHist, 182 
EntryHistUse, 183 
font, 178 
FontColorUse, 179 
FontUse, 178 
formatting, 178 

FrameStyle, 184 
Height, 181 
Hint, 181 
HintShow, 182 
Left, 181 
Object Inspector, 178 
ObjName, 181 
SelectLIst, 182 
SelectListUse, 182 
Top, 181 
Width, 180 

Edit Fields, 178 
Edit menu, 67–69, 67–69 
entry history, 31, 77 
Entry History (command), 77 
EntryHist, 182 
EntryHistUse, 183 
Exit (command), 67 
Expand Requesters (command), 

225 

F 
File menu, 64–67 
Filename, 140 
Font 

buttons, 134 
edit fields, 178 
tabbed notebooks, 164 
text objects, 127 

FontColorUse 
activating, 92 
edit fields, 179 
text objects, 128 

fonts and colors, 23 
FontUse 

activating, 91 
buttons, 135 
edit fields, 178 
tabbed notebooks, 165 
text objects, 128 

Format Painter, 101 
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Format Painter (button), 95 
formatting 

buttons, 132 
edit fields, 178 
frames, 146 
multimedia objects, 151 
objects, 101, 110 
pictures, 140 

Formatting, 110 
frames, 25, 75, 146 

formatting, 146 
FrameStyle, 147 
Height, 149 
inserting, 146 
Left, 148 
Object Inspector, 146 
ObjName, 148 
Top, 148 
Width, 148 

FrameStyle 
edit fields, 184 
frames, 147 
multimedia objects, 152 

G 
Gradient, 122 
GradientDirection, 123 
gradients, 26 
GradientUse, 123 
graphics, 26 

H 
Height 

buttons, 136 
edit fields, 181 
frames, 149 
multimedia objects, 154 
pictures, 143 
tabbed notebooks, 165 
text objects, 130 

Help menu, 92 
Hint 

buttons, 138 
edit fields, 181 
multimedia objects, 154 
pictures, 145 
tabbed notebooks, 165 

hints, 33, 138, 145, 154, 165, 
181 

HintShow 
buttons, 138 
edit fields, 182 
multimedia objects, 155 
pictures, 145 
tabbed notebooks, 165 

I 
Initial Requester, 46 
Insert Button (button), 96 
Insert Button (command), 73, 

132 
Insert Frame (button), 96 
Insert Frame (command), 75 
Insert Multimedia (button), 

96 
Insert Multimedia (command), 

76 
Insert Picture (button), 96 
Insert Picture (command), 74, 

139 
Insert Tabbed Notebook 

(button), 96 
(command), 159 

Insert Tabbed Notebook 
(command), 76 

Insert Text (button), 95 
Insert Text (command), 72, 125 
inserting 

buttons, 73, 132 
frames, 75, 146 
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multimedia, 76 
objects, 105 
pictures, 74, 139 
tabbed notebook, 76 
text, 72 

install 
Screen Designer, 36, 39 

installing Data Explorer, 214 
InstallShield wizard, 39 
intranet, 131, 138, 145, 156 

J 
Java, 17 

K 
keyboard mapping, 29 
Keyboard Mapping (command), 

81 

L 
Launch Data Explorer 

(command), 67 
Left 

buttons, 136 
edit fields, 181 
frames, 148 
multimedia objects, 154 
pictures, 143 
tabbed notebooks, 166 
text objects, 130 

Let (statement), 204 

M 
macro 

create in Screen Designer, 207 
editing, 80 

launching, 183 
launching, 124 

Macro, 137, 143, 156, 183 
Macro (command), 80 
macros 

associate with button, 209 
associate with edit field, 209 
associate with multimedia 

object, 209 
associate with object, 209 
associate with picture, 209 
associate with requester 

object, 209 
running from legacy 

applications, 189 
testing, 212 
types of macros, 190 

main work area, 60 
mapping 

Tandem keys, 82 
MATT-CONF, 44, 46 
Matterhorn 

making calls to DLL, 191 
operating as DDE-client, 190 
operating as DDE-server, 190 

Matterhorn Configuration, 47 
Matterhorn for Windows, 16 
Matterhorn macro language, 34, 

188–211 
Identifier parameter type, 194 
Integer parameter type, 194 

Matterhorn Pathway system, 38, 
43 

Matterhorn profile, 40, 55 
Matterhorn Profile 

definition, 40 
MattOpen, 19, 81 
MATT-POBJ, 57 
MattWeb, 17 

intranet, 18 
Matterhorn Pathway system, 

38 
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MCI, 149 
menu bar, 61 
Microsoft Explorer, 216 
Miscellaneous section, 47 
MMExit, 123 
MMExitUse, 123 
MMFile, 155 

buttons, 137 
pictures, 144 

MMIntro, 123 
MMIntroUse, 124 
MMObject 

buttons, 137 
pictures, 144 

MMSelect 
buttons, 137 
pictures, 144 

moving 
objects, 114 

multimedia, 27, 76, 149 
associating with button, 137 
launching, 123, 137, 144, 155 

multimedia object 
associate with macro, 209 

multimedia objects 
Click, 155 
creating, 150 
formatting, 151 
FrameStyle, 152 
Height, 154 
Hint, 154 
HintShow, 155 
Left, 154 
MMFile, 155 
Object Inspector, 151 
ObjName, 154 
OnLoad, 155 
Stretch, 155 
Top, 153 
URL, 156 
URLUse, 156 
Width, 153 

O 
Object Inspector, 98–101, 110, 

160 
buttons, 132 
edit fields, 178 
frames, 146 
hiding, 101 
navigating, 99 
pictures, 140 
requester object, 120 
text objects, 126 

Object Inspector (command), 85 
Object menu, 70–76 
objects 

copying, 69, 109 
creating, 105 
cutting, 68, 109 
definition, 53, 104 
deleting, 69, 112 
formatting, 101, 110 
inserting, 105 
moving, 114 
pasting, 69, 109 
resizing, 114 
restoring, 112 
selecting, 69, 106 
working with, 103–15 

ObjName, 154 
buttons, 133 
edit fields, 181 
frames, 148 
pictures, 143 
tabbed notebooks, 166 
text objects, 129 

occurs fields, 87 
OnAccept, 124 
OnDisk, 143 
OnLoad, 155 
Open Requester (button), 

94 
Open Requester (command), 65 
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Open Requester dialog box, 118 
Options menu, 83–92 
overlay areas, 185 

P 
Paste (command), 69 
pasting 

objects, 109 
picture 

associate with macro, 209 
Hint, 145 

pictures, 26, 74, 139 
associate with multimedia, 

144, 158 
ClickDbl, 141 
Filename, 140 
formatting, 140 
Height, 143 
HintShow, 145 
inserting, 139 
Left, 143 
MMFile, 144 
MMObject, 144 
MMSelect, 144 
Object Inspector, 140 
ObjName, 143 
OnDisk, 143 
subobjects of, 218 
Top, 142 
URL, 145 
URLUse, 145 
Width, 141 

POBJ search path, 47, 56 
Preferences (command), 86, 225 
Preferences dialog box, 86 

in Data Explorer, 225 
Preserve Object Names 

(command), 227 
Profile dialog box, 40 
Profile Name window, 41 

R 
Redo (button), 97 
Redo (command), 68 
Redraw, 92 

(button), 97 
requester 

merging, 187 
opening, 65, 117 
redirecting, 81 
saving, 66, 117 
screen number, 65, 118 
updating, 186 

requester object 
associate with macro, 209 
Object Inspector, 120 

requester object, the 
launching a macro from, 211 

Requester Object, the, 105, 119 
ButtonPanelShow, 120 
Color, 121 
ColorUse, 122 
Gradient, 122 
GradientDirection, 123 
GradientUse, 123 
MMExit, 123 
MMExitUse, 123 
MMIntro, 123 
MMIntroUse, 124 
OnAccept, 124 
WallpaperBitmap, 124 
WallpaperPos, 124 
WallpaperUse, 125 

Requester Replace (command), 
81 

resizing 
objects, 114 

restore 
objects, 68 

Restore Objects (button), 
97 

Restore Objects (command), 68 
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restoring 
tabbed notebooks, 167 

restoring objects, 112 
from a tabbed notebook, 167 

RSC, 42, 56 

S 
Save Requester (button), 94 
Save Requester (command), 66 
Screen Designer, 45 

application window, 59 
configuring, 40–50 
create macros, 207 
database, 48, 53 
elements, 58–102 
features, 15, 21 
getting help, 92 
installing, 36, 39, 36–39 
launching in Data Explorer, 

231 
Matterhorn, 52 
Matterhorn for Windows, 16 
Matterhorn profile, 40 
MattOpen, 19 
MattWeb, 17 
objects, 53 
operation of, 51–58 
prepare session, 46 
running a redesigned 

requester, 50 
starting, 117 
system requirements, 37 

Screen Designer Database 
Data Explorer, 219 
working with, 219 

Select All (command), 69 
Select Object (command), 69 
Select Objects (button), 94 
selecting 

multiple objects, 107 
objects, 106 

selection list 
editing, 80 

selection lists, 30, 169 
create manually, 171 
creating, 171 
definition, 169 
generate from DLL, 175 
load from Tandem, 174 
load from textfile, 172 
sources, 170 

Selection Lists (command), 79 
selection mode, 94 
selection pointer, 94 
SelectList, 182 
SelectListUse, 182 
Session Name, 43, 46 
SetCursor, 205 
shortcut key 

associate with button, 134 
Show Messages (command), 67 
Show Subobjects (command), 

226 
Stretch, 155 
system element, 217 

T 
tab caption, 166 
Tab Editor dialog box, 166 
tabbed notebooks, 15, 28, 158 

16-bit, 167 
32-bit, 167 
creating, 159 
Font, 164 
FontUse, 165 
formatting, 164 
Height, 165 
Hint, 165 
HintShow, 165 
Left, 166 
moving object to, 161 
ObjName, 166 
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restoring objects, 167 
subobjects of, 218 
tabs, 163 
Tabs, 166 
Top, 166 
Width, 166 

tabs 
creating, 163 
deleting, 163 
naming, 163 

Tabs 
tabbed notebooks, 166 

Tandem 
information, 43 
objects, 104 

Tandem keys 
mapping, 82 

text objects 
Caption, 127 
Color, 128 
ColorUse, 129 
Font, 127 
FontColorUse, 128 
FontUse, 128 
formatting, 126 
Height, 130 
inserting, 125 
Left, 130 
Object Inspector, 126 
ObjName, 129 
Top, 130 
Transparent, 131 
URL, 131 
URLUse, 131 
Width, 130 

The Matterhorn Suite, 16 
title bar, 61 
tool bar, 62, 93–97 
Top 

buttons, 136 
edit fields, 181 
frames, 148 

multimedia objects, 153 
pictures, 142 
tabbed notebooks, 166 
text objects, 130 

Transparent 
text objects, 131 

U 
UMP, 56 
Undo (button), 96 
Undo (command), 68 
updating 

requesters, 186 
URL 

buttons, 138 
multimedia objects, 156 
pictures, 145 
text objects, 131 

URLs 
activate from requesters, 131, 

138, 145, 156 
URLUse 

buttons, 139 
multimedia objects, 156 
pictures, 145 
text objects, 131 

W 
WallpaperBitmap, 124 
WallpaperPos, 124 
WallpaperUse, 125 
Width 

buttons, 136 
edit fields, 180 
frames, 148 
multimedia objects, 153 
pictures, 141 
tabbed notebooks, 166 
text objects, 130 

Window menu, 234 
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windows arranging in Data Explorer, 
234 
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